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Document Conventions
Caution: This is a Caution or Warning icon. When it appears, the corresponding text indicates a cautionary 

statement by which you must abide.

 Note: This is a Note icon. When it appears, the corresponding text indicates a helpful note or tip when 
using the feature.

The following usage conventions are used throughout the Intelligent Library System User 
Manual.

Button Name - This describes a button or selection on the screen. For example, the 
<DONE> button is represented in this document as Done.

Key Name - This describes a keystroke on a keyboard. For example Ctrl represents the 
Control key on a keyboard.
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Important Information to our Users in North America
FCC Regulatory Compliance Statement

Checkpoint Systems, Inc., offers Radio Frequency Identification Products that have been FCC certified or 
verified to 47 CFR Part 15 Subparts B/C and/or 47 CFR Part 18. Appropriately, one of the following labels 
will apply to the approval:

NOTE: This equipment has been tested and found to comply with the limits for a class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.

- OR -

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) including this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation, which 
may include intermittent decreases in detection and/or intermittent increases in alarm activity. 

- OR -

NOTE:  This equipment has been tested and found to comply with the limits for a miscellaneous type 
ISM device, pursuant to Part 18 of the FCC Rules. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. However, there is no guarantee that interference 
will not occur in a particular installation. If this equipment does cause harmful interference to radio 
communications reception, which can be determined by turning the equipment off and on, please 
contact Checkpoint Systems, Inc., at 1 (800) 257-5540 for further assistance.

Equipment Safety Compliance Statement

Checkpoint Systems Radio Frequency Identification products have been designed to be safe during normal 
use and, where applicable, certain components of the system or accessory sub-assemblies have been 
certified, listed or recognized in accordance with one or more of the following Safety standards: UL 1012, 
UL 1037, UL 1310, UL 60950-1, CSA C22.2 No. 205, CSA C22.2 No. 220, CSA C22.2 No. 223, CSA 
C22.2 No. 60950-1. Additional approvals may be pending.

WARNING:  Changes or modifications to Checkpoint’s Radio Frequency Identification (RFID) 
equipment not expressly approved by the party responsible for assuring compliance could void the user’s 
authority to operate the equipment in a safe or otherwise regulatory compliant manner.
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Important Information to our Users in Europe
CE Compliance Statement

Where applicable, Checkpoint Systems, Inc., offers certain Radio Frequency Identification (RFID) products 
that have CE Declarations of Conformity according to R&TTE Directive 99/5/EC.

System Electromagnetic Compatibility (EMC), has been tested and notified through Spectrum Management 
Authorities using laboratories, whereby, conformity is declared by voluntarily accepted European 
Telecommunications Standards Institute (ETSI) standards EN 301489-3 and EN 300330-2.

NOTE: Certain Radio Frequency Identification (RFID) equipment have been tested and found to conform 
with the CE emission and immunity requirement in Europe. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Under unusual circumstances, interference from external 
sources may degrade the system performance, which may include intermittent decreases in detection and/or 
intermittent increases in alarm activity. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment experiences frequent interference from external sources or does 
cause harmful interference to radio communications reception, which can be determined by turning the 
equipment off and on, please contact a Checkpoint Systems representative for further assistance.

Equipment Safety Compliance Statement

Checkpoint Systems Radio Frequency Identification products have been designed to be safe during normal 
use and, where applicable, certain components of the system or accessory sub-assemblies have been 
declared safe according to the European Low Voltage Directive (LVD) by being certified, listed, or 
recognized in accordance with one or more of the following European safety standards; EN 60950, EN 
50364, EN 60742. Additional approvals may be pending.

WARNING:  Changes or modifications to Checkpoint’s Radio Frequency Identification equipment not 
expressly approved by the party responsible for assuring compliance could void the user’s authority to 
operate the equipment in a safe or otherwise regulatory compliant manner.
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C H A P T E R

CHAPTER 0INTRODUCTION
The Intelligent Library System Open Plus 3.0 (ILS) is an integrated security tracking and 
database system that maintains a library’s collection using Radio Frequency Identification 
(RFID) to wirelessly coordinate the subscription status of library materials. This protects 
collections, streamlines operations, and improves patron service. When using ILS, 
libraries reduce losses, enhance staff productivity, increase circulation flow, and improve 
patron satisfaction. ILS operates in conjunction with the library’s Library Management 
System (LMS) or Automated Circulation System (ACS).

ILS includes the following components: 

• RFID tag
• Patron Identification Card
• Intelligent Sensor
• Patron Self-Checkout Station
• Staff Station Reader
• Intelligent Library Controller (Application Server)
• Portable Inventory Reader (optional)
• Exception Ticket Printer (optional)
• ILS Remote Monitor (optional)
• CheckVIEW (optional)
• CheckPASS (optional)
• Tag Programming Station (optional)
• DiscMate (optional)
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The following configuration illustrates an example of the ILS components and 
connections in a typical ILS setup.

Figure 1.1 Sample Intelligent Library System Components

Note: Your specific ILS configuration may not include one or more of the components shown.

Tag Programming Station

RFID ISO Tag

Intelligent SensorsStaff Station Reader

Portable Reader

Intelligent Library Controller

Library Management 
System

 Self-Checkout Station
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Library Network Topology
In addition to supporting the Single Branch topology, ILS Version 3.0 supports the 
following library topologies:

• “Single Branch”
• “Single Server, Multi-Branch Architecture” 
• “Peer-to-Peer Communication”
Figure 1.2 depicts the library network topologies supported by ILS Version 3.0.

Figure 1.2 Library Network Topologies Supported by ILS Version 2.5

Single Branch
The Single Branch scenario represents the current implementation of ILS, where one 
Application Server controls all of the components within a single branch library.

Application Server

Local Security 
Controller

= branch

Single Branch

Single Server,
Multi-Branch

Peer-to-Peer

Main BranchPeer Branch

Main Branch

Peer Branch Peer Branch
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Single Server, Multi-Branch Architecture
New with this release, ILS Version 3.0 enables a single server to manage the circulation of 
not only its only branch but multiple remote branches as well, granting the administrator 
greater power and ease to manage the entire system. In this scenario, Local Security 
Controllers are used to assist the Application Server.

The Local Security Controller (LSC) is a combination hardware and software solution for 
a multi-branch ILS deployment. The LSC assists the Intelligent Library Controller in 
maintaining the response speed of Exit Interrogators, managing the connection between 
the Exit Interrogators at the branch and the remote Application Server to provide 
maximum caching performance. The LSC also enables the intelligent sensors to operate 
(with limitations) if the main server is down. This scenario is normally used with libraries 
containing up to 20 branches.

Peer-to-Peer Communication
New with this release is the ability to run a library’s security and inventory management 
system from any ILS Server. This enables a granular redundant system that is crash 
resistant because each node can run the entire system, as well as, holding a complete copy 
of the checkout cache database at any time. 

The main Application Server communicates to each node (peer server) the latest 
circulation database in a configurable matter of time (from seconds to hours or even 
daily); meaning circulation records are nearly always up to date. This means that exit gates 
(intelligent sensors) are updated throughout the day at every branch. This allows a patron 
to walk to another branch (for example on a college campus) and their library material will 
respond with the correct check-in or checkout status. This scenario is normally used for 
libraries containing more than 20 branches.
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Document Overview
This manual provides a general overview of the ILS technology and illustrates the use and 
operation of each component.

This manual has been designed for the librarian and administrator and contains all the 
information necessary to take full advantage of the system capabilities. The Intelligent 
Library System enhances your library experience because of the system's inherent ease of 
use and efficiency.

This manual is organized into chapters, with each chapter describing a system peripheral, 
such as the Self-Checkout Station. Each peripheral is designed with a specific system role 
in mind. For example, patrons typically use the Self-Checkout Station, while Library staff 
use the Portable Inventory Reader. Read the sections that apply to your role for ILS 
system operation.

This manual is divided into the following chapters that cover system peripherals and 
important ILS tasks.

• Introduction (See page 1-1)
• Application Server (See page 2-1)

• Self-Checkout Station (See page 3-1)
• Portable Reader (See page 4-1)
• ILS Remote Monitor (See page 5-1)
• CheckVIEW (See page 7-1)
• Exception Ticket Printer (See page 6-1)
• CheckPASS (See page 11-1)
• Tagging procedures (See page 8-1)
• Troubleshooting Guide (See page 12-1)
• System Maintenance Guide (See page 13-1)

Intended Audience
This document is intended for library staff and administrators as well as Checkpoint 
Systems field service staff. The library staff includes librarians, support staff, and 
temporary staff. The Field Service staff is comprised of the Checkpoint installers and 
technical support personnel. These audiences need to understand the basic functions, 
operations, and procedures related to the ILS.



1-6 I L S  2 . 5  U s e r  G u i d e

System Overview
The following sections describe how the Intelligent Library System Open Plus interacts 
with a library’s circulation system to maintain its collection.

How RF Query Tags
The Intelligent Library components - Self-Checkout Station, Intelligent Sensor, Staff 
Station Reader, and Portable Reader - all use a Radio Frequency (RF) antenna and 
transceiver system (interrogator) which detects and reads the RFID tags. Communications 
occur when an interrogator’s radio field is triggered by a tag passing through it. When 
energized, the tag presents the programmed item-specific information to the interrogator 
for further processing.

Figure 1.3 RFID Tag is interrogated

The data, routed by the Intelligent Library Controller, is compared to the Library 
Management System (LMS) database, in order to identify the checkout status of an item.

How ILS Maintains the Library’s Collection Database
The Intelligent Library Controller is the communications gateway between the ILS 
subsystems and the library’s Library Management System (LMS) so that the check-in, 
self-checkout, inventory management, and security activities can all be accomplished.

All library materials including books, CD/DVD materials, videotapes, and cassettes are 
tagged with a permanent RFID tag. This tag contains information that uniquely identifies 
the item within the library circulation database. Patron cards identify patrons when the 
card is scanned at the Self-Checkout Station. The card stores coded information unique to 
the individual patron that identifies the user to the Library Management System. The 
patron can then be validated as eligible or ineligible to use the library checkout privilege.

Sample Interrogator 
(Staff Station Reader)

RFID Tag

101A
U

.....

??
??

??
...

...
..

Radio Field
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Patron Checkout and Check-In
Patrons use Self-Checkout Stations to checkout library materials. Self-Checkout Stations 
include a patron card reader, an RFID tag, a touch screen monitor, and a printer in one 
compact unit. This provides the patron with library transaction capability without any 
librarian assistance. A patron scans the RFID Patron Card and library materials, 
identifying the patron and linking the library materials to the individual through a 
communications session with the Library Management System via the Intelligent Library 
Controller. 

When the patron checks out materials, the patron and checked out item information is 
stored in both the LMS and ILS databases, allowing ILS to operate in both on- and off-line 
modes. When materials are checked out from a Self-Checkout Station, the ILS asks the to 
the patron to checkout items from the LMS. If privileges are granted then a checkout 
request to the LMS is generated for each item. 

If the patron is checking in library materials, the ILS makes a check-in request to the LMS, 
which updates its database and reports the result back to the ILS.

Staff Checkout and Check-In
The library staff typically uses a Staff Station Reader in situations where a patron needs 
help from a librarian or when a librarian is checking in or checking out library materials. 
The Staff Station Reader interrogates tags and functions the same as current bar code 
scanners used in Library Management Systems. 

Book Return Check-In
The Staff Station Reader can also be integrated into a book return slot. When library 
materials are placed in the book return, the tags on the items are read and sent to the LMS. 
The LMS then updates its database and passes back the transaction status to the ILS.
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Checkout Process
Diagrammed here is how library materials are checked out.

Figure 1.4 Check Out Flow

1 The RFID tag, encoded with the necessary information, is wirelessly read by either the 
Self-Checkout Station or the Staff Station Reader. 

2 The Station or Reader communicates with the Intelligent Library Controller which, 
after successful verification, communicates back to the Station or Reader that the book 
is checked out.

3 When exiting the library, the book passes through the Intelligent Sensors which 
verifies the status of the book and allows it to exit the library without triggering an 
alarm.

Self-Checkout Station

Staff Station Reader

Intelligent Library Controller

Intelligent Sensors
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Inventory Collection
You can use the Portable Inventory Reader to inventory the library’s contents or to find 
individual items. The unit is a battery powered hand-held device that interrogates RFID 
tags as you walk by tagged items, when the unit detection head is within a ten-inch 
(25 cm) radius.

The Portable Inventory Reader searches for specified items using its search function. 
Single or multiple item IDs can be uploaded to the data terminal and when a scanned ID 
matches, the user receives an audible alert and the ID is displayed on the data terminal.

Figure 1.5 Portable Inventory Reader Taking Inventory

The Item Identifiers on the tagged articles are read and stored in a Portable Data Terminal 
which can be downloaded in real-time to the Intelligent Library Controller using the 
wireless data-terminal option or downloaded after the inventory is completed as a batch 
file using the standard data terminal. The inventory data is then communicated to the 
Library Management System, which compares the information from the Portable 
Inventory Reader to item information in the circulation database. 
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Exit Monitoring
The Intelligent Sensor protects exit/entry aisles against unchecked library materials 
leaving the secured area by determining whether tagged items have checked (authorized/
no alarm) or unchecked (unauthorized/alarm) events.

Figure 1.6 Exit Monitoring

Programming Tags
The Tag Programming Station enables libraries to read and create their own RFID tags 
and print barcode labels. This can also be used to convert library materials with barcodes 
to RFID tags programmed with the barcode value. A tag format file (created by 
Checkpoint field service staff using the Tag Programming Application) is used to program 
the tags in a compatible format. Tags are programmed by printing them with the Tag 
Programming Station. See “RFID Tag is interrogated” on page 1-6 for an illustration of 
this process.

Off-line Processing
The Off-line Processing feature enables the Intelligent Library Controller and 
Self-Checkout Stations to continue operating when disconnected from the library’s 
circulation system. While the circulation system is offline, the Intelligent Library 
Controller records significant events on the system, which are then reported to the 
circulation server when synchronization reoccurs. For example, at the time of 
synchronization, the due date is sent to the circulation server. 

When Off-line Processing is turned on, the word ON appears next to Off-line Processing. 
The feature is turned on or off by Checkpoint field service personnel by setting a table 
parameter on the Intelligent Library Controller. If using the Bridge Interface (“ILS 
Without an LMS Connection”), Off-line Processing should never be turned on.

Intelligent Library Controller

Intelligent Sensors
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ILS Without an LMS Connection
It is possible for ILS to operate without an active Library Management System (LMS) 
interconnection using the ILS Bridge Interface feature. The Bridge Interface feature 
allows libraries with non-supported circulation vendors or no circulation systems to use 
the security and Staff Station Reader functionality of the ILS. 

With the Bridge Interface, the user of the ILS Control program monitors and changes the 
operation mode (check-in or checkout) of the Staff Station Readers. A library that is using 
the Bridge Interface can use a Staff Station Reader for checkout, but cannot use a 
Self-Checkout Station.

Components
The following sections describe in detail each of the ILS system components.

RFID Tag
The RFID tag an advanced RFID integrated circuit bonded to a label which is then 
attached to library material.

Figure 1.7 RFID Tag

The tag stores 96 programmable bits of information about an item that can be read on a 
single Radio Frequency, 13.56 MHz, up to a distance of 4 feet (1.2 m). The tag allows for 
the reading of multiple tags using an anticollision algorithm, as well as error detection and 
correction methods.
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ILS Intelligent Sensor
The ILS Open Plus Exit Gate provides security at library exits and corrals by generating a 
radio field that gathers tag information from a distance up to 24 inches (61 cm). Two 
intelligent sensors form a secure aisle up to 48 inches (122 cm) wide for tag detection 
range. Additionally, the sensor communicates back to the Library Management System 
via the Intelligent Library Controller in real-time, determining whether an item has been 
checked out. If items in the interrogation field are not properly checked out, an alarm 
sounds and the book title appears on an exit alarm screen.

Figure 1.8 ILS Intelligent Sensors

Local Security Controller
The Local Security Controller (LSC) is a combination hardware and software solution for 
a single server, multi-branch ILS deployment. The LSC assists the Intelligent Library 
Controller in maintaining the response speed of Intelligent Sensors (exit gates), managing 
the connection between the Exit Interrogators at the branch and the remote Application 
Server to provide maximum caching performance. The LSC also enables the exit gates to 
operate (with limitations) if the main server is down. This scenario is normally used with 
libraries containing up to 20 branches.

Figure 1.9 Local Security Controller
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Staff Station Reader
The Staff Station Reader functions as an interface to ILS and circulation activities for 
library personnel. The Staff Station Reader reads RFID tags when a book is placed on the 
reader at up to 12 inches (30 cm) from the reader in a vertical direction. The Staff Station 
Reader communicates through data links with both the Library Management System and 
ILS, providing library staff the ability to perform typical functions with both the library 
system and RFID tagged items. For example, library staff can find the status of RFID 
tagged items that have been processed by ILS.

Figure 1.10 ILS Staff Station Reader

Patron Self-Checkout Station II
The Self-Checkout Station enables a library patron to checkout library materials without 
the assistance of the library staff. The system may report messages if there is a problem 
conducting the checkout transaction; for example, overdue fines have locked the patron’s 
account.

Figure 1.11 ILS Self-Checkout Station
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The Self-Checkout Station supports multiple languages simultaneously. When 
programmed, a language selection screen is presented to the patron to select a language for 
the self-checkout transaction.

A typical scenario for a patron to check out a book is as follows. 

1 A patron arrives at the Self-Checkout Station and selects a language (if using multiple 
languages). 

2 The patron is identified by the system with their patron ID card. 
3 The system confirms the patron’s eligibility to conduct a transaction through validation 

of the patron ID card. 
4 The patron is led through the transaction process by communication with the system 

through a touch screen monitor. The patron checks out items by passing them one at a 
time over a short-range wireless interrogator that is located in the Self-Checkout 
Station. 
a The short-range interrogator generates a radio field, which activates and 

interrogates the tagged item. 
b The interrogated item ID is passed to the Intelligent Library Controller. 
c The Intelligent Library Controller determines the item status and actions that can be 

taken via communications with the Library Management System.
d The Intelligent Library Controller updates the Self-Checkout Station, which notifies 

the patron about their transaction status. 
5 After the patron scans all the items to be checked out, the patron touches Done and 

receives a receipt for the transaction, listing all materials checked out and the 
respective due dates.

Portable Inventory Reader
The Portable Inventory Reader provides inventory management functions, such as 
inventory reconciliation and item search. The device consists of a hand-held, rechargeable 
battery operated wand that generates a radio field that scans RFID tagged items. The wand 
is attached with cabling to a data terminal, which can be carried in one hand or strapped 
onto the wrist, storing information read by the wand. The data stored in the terminal can be 
downloaded to the Intelligent Library Controller in real-time either with the standard data 
terminal or wirelessly. 
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The wand can also be used for item searches and shelf order checking. Item information is 
uploaded to the data terminal, allowing you to scan the ID. Once found, an audible alert 
sounds and the ID displays.

Figure 1.12 ILS Portable Reader

Intelligent Library Controller
The Intelligent Library Controller software:

• Functions as the communications gateway between the Intelligent Library subsystems 
and the Library Management System

• Identifies and configures all peripheral Intelligent Library sub-systems
• Tracks and directs all ILS transactions
The Intelligent Library Controller operates whether the Library Management System is 
on-line or off-line. In off-line mode, the server tracks whether an item is being checked 
out, checked in, and determines whether tagged items going through secured areas are 
authorized. If unauthorized items are detected by the system, the server signals the 
Intelligent Sensor (the gates) to alarm. Any transactions that occur independent of the 
Library Management System are updated when the ILS system comes back on-line.

The Intelligent Library Controller interfaces to the Library Management System and other 
subsystem components using the 3M© protocol (SIP2) over an Ethernet Network Interface 
Card (NIC). The Ethernet NIC uses the TCP/IP protocol and session and the physical 
cable is 10BaseT. 

Exception Ticket Printer
New in ILS Version 3.0 is the option to automatically print a hold receipt for library 
material at designated book drops. This means that when library material is returned via a 
book drop, if the library material is designated with a hold, a printer automatically prints a 
receipt. This frees library staff from having to manually check-in each item for its hold 
status. Instead, a staff member just checks the print receipt and then secures the receipt 
with the item on hold.

Inventory Wand

Portable Data Terminal
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One exception ticket printer can service multiple interrogators. This means that a receipt 
might print at the exception ticket printer near Drop Box A for a book that is returned at 
Drop Box B. 

CheckVIEW
New in Version 3.0 is the CheckVIEW utility, enabling library staff to remotely monitor 
up to four different Self-Checkout Stations at one time from any computer within the 
library. This enables library staff to manage issues such as:

• Patrons who are having difficulty using the touch screen
• Stations that may have hardware or system problems
• Viewing the patrons’ check out list to reconcile any discrepancies concerning 

availability
Staff members can use their mouse and keyboard to assist patrons by assuming control of 
a specific Self-Checkout Station window to step a patron through a checkout procedure.

ILS Remote Monitor
New in Version 3.0, ILS Remote Monitor is an optional utility that allows library staff 
operating in a single server, multi-branch or peer-to-peer environment to view the status of 
other branches on the network from any computer on that network. This enables a staff 
member to monitor system status, identify a troublesome Self-Checkout Station, print a 
pre-run report, or transfer files. 

The ILS Remote Monitor works on any computer (with a web browser) that is connected 
to the library network. 

Tag Programming Station
The Tag Programming Station programs RFID tags, either with the retrospective item 
identifier from the existing barcode or when new materials are added to the collection. 
This reduces the time it takes to convert a library collection from barcode to RFID tags as 
well as add additional materials. 
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The Tag Programming Station enables the library to easily link new materials into ILS 
instead of waiting several weeks for pre-programmed tags. 

Figure 1.13 Tag Programming Station

When adding a new item to the collection and programming the RFID tag, the library can 
also print a barcode label. In many cases, libraries will continue to support the use of 
barcodes in addition to the RFID tags, mainly for compatibility with other branch libraries 
still using barcodes. 

Using the Tag Programming Application, libraries program the RFID tags by printing 
them. Refer to “Affixing Tags” on page 8-1 for instructions on how to attach circuits to 
library materials.

CheckPASS
CheckPASS is an optional utility that allows library patrons to pay library fees at a 
Self-Checkout Station, without staff assistance. Outside of the ILS product, patrons use a 
self-service unit to add cash to their account balances. Within ILS, patrons are reminded of 
outstanding library fees when they attempt to check out materials. They can then pay with 
the touch of a button at the Self-Checkout Station. Patrons save time and library staff is 
freed to perform other tasks.

See “CheckPASS” on page 11-1 for further information.
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Notes
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C H A P T E R

CHAPTER 0APPLICATION SERVER
The Application Server hardware hosts the Intelligent Library Controller software, which 
is the core-processing component of the Intelligent Library System Open Plus. The 
Intelligent Library Controller performs many functions, including:

• Storing transactions performed at the Self-Checkout Stations
• Downloading inventory data from the ILS Portable Inventory Reader
• Generating reports
• Connecting to the Library Management System (LMS)
In addition, the Intelligent Library Controller provides a single station for system 
configuration and diagnostics. If the LMS becomes unavailable, the Intelligent Library 
Controller can support automated checkout functions without the LMS, using a feature 
known as Off-Line Processing. Off-Line Processing is a site-specific option, so it may not 
be available to you. 

This chapter describes the Application Server and its components and how they operate 
within the ILS. It also provides information on:

• Checking system, host, interrogator, and exit alarm status (page 2-2)
• Scheduling Checkout Cache Synchronization and Host Reconnections (page 2-6)
• Synchronizing the Checkout Cache (page 2-8)
• Downloading inventory information from the Portable Inventory Reader (page 2-10)
• Generating, saving, and printing reports, including Checkout Discrepancy, Patron 

Discrepancy, Exit Alarm, Check-In Exception, and Generic reports (page 2-11)
• Communicating and coordinating data exchange with Local Security Controllers at 

remote branches (page 2-25)
• Working in Bridge Mode (page 2-25)
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Check System Status
The Intelligent Library Controller provides current information on the status of the ILS 
system and ILS Portable Inventory Reader. You also use it to generate reports.

The four main sections of the Intelligent Library Controller window include: 

• Self-Checkout Station Status (page 2-2)
• Host Status (page 2-4)
• Interrogator Status (page 2-4)
• Exit Alarms (page 2-6)
With the exception of the Interrogator Status section, these sections can be displayed or 
hidden from view.

Figure 2.1 Intelligent Library Controller window

You navigate using the menu bar or the button bar. The button bar provides shortcut 
buttons to the most commonly-used features. Use the Hide button to hide or show 
individual areas of the window.

Self-Checkout Station Status
The Self-Checkout Station Status section displays information about the operational state 
of the Self-Checkout Stations, including:

• Station Name
Displays the name of each Self-Checkout Station.

Button
Bar

Menu
Bar

Self-Check
out Station
Status

Host
Status

Interrogator
Status

Exit Alarms
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• System State
Identifies whether or not the Self-Checkout Station is connected (on-line) or not 
connected (off-line) to the LMS.

• Printer State
Displays messages about the printer, including: OK, out of paper, I/O error, and so on. 
These messages are generated by Windows.

Figure 2.2 System Status Section

To display the System Status Section:

Click System Status in the button bar. See Figure 2.3.

Figure 2.3 System Status Button

OR
Select Status > System Status Display in the menu bar. See Figure 2.4.

Figure 2.4 System Status Menu Selection
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Host Status
The Host Status section notifies you if the host (Library Management System) is on-line or 
off-line and whether or not Off-Line Processing is enabled.

Figure 2.5 Host Status Area

The Off-Line Processing feature allows a library to configure the Intelligent Library 
Controller and Self-Checkout Stations so they can continue to operate while the LMS is 
off-line. While the LMS is off-line, the Intelligent Library Controller records significant 
events (such as check-ins and checkouts) and reports them to the LMS later, during cache 
synchronization. 

Off-Line Processing must be enabled on an Application Server that uses the Bridge 
Interface. The Bridge Interface allows libraries with non-supported circulation vendors, or 
no LMS at all, to use the ILS security and Staff Station reader features. See “Working with 
the Bridge Interface” on page 2-25 for more information.

This feature is optional and may or may not be enabled (allowed) at your site. 

• If Off-Line Processing is enabled, the Off-Line Processing status is ON.
• If Off-Line Processing is disabled, the Off-Line Processing status is OFF.

Interrogator Status
The Interrogator Status section shows information about interrogators (Self-Checkout 
Stations, Staff Station Readers, and Intelligent Sensor exit gates), including:

Figure 2.6 Interrogator Status Section

• Description
The IP address, port number, and the location of the interrogator.

• Branch
The library branch at which the interrogator resides.

• Op Mode
Used in bridge mode to denote the function of the interrogator, including Check In, 
Checkout, Drop Box, or Exit. If your site does not use the Bridge Interface, the Op 
Mode denotes the function of the interrogator, including Drop Box, Exit, or Tag Pad.
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• Status
Operational status of the interrogator (on-line or off-line).

• Details
Shows a history of connections for each interrogator, including IP address, port 
number, whether the connection was a connect or disconnect, connection date, and 
connection time. The number in parentheses (#) shows how many reconnections were 
attempted. (A high number of attempts may indicate network problems.)

This section cannot be hidden from view. 

Edit Interrogator
To view or edit the information for an individual interrogator: 

1 In the Intelligent Library System Control window, select Maintenance > Edit 
Interrogators.

2 Type the ILS username and password in the ILS Login window. The default 
username is ils and the default password is maint. The Edit Interrogator window 
displays:

Figure 2.7 Edit Interrogator Window

3 If necessary, use the drop-down list boxes to select the desired Interrogator (desc.) 
and Branch (Figure 2.7). In the example above, SELFCHECKOUT1 will be assigned 
to the Main branch.

4 Make the desired modifications, and click Save. For example, you can change the 
description of the component in the Description drop-down menu by typing over the 
existing description. Click Cancel to clear any changes you do not wish to save.

5 Close the Edit Interrogator window by clicking the X.
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Exit Alarms
The Exit Alarms section displays information about each exit alarm that has occurred, 
including:

Figure 2.8 Exit Alarms Section

• Date and time of exception
• Item identifier
• Book Title of the exception
• Branch at which the exception occurred
• Exit location is the exit gate at which the exception occurred

Scheduling Checkout Cache Synchronization and Host 
Reconnections

Use Task Scheduler to schedule Checkout Cache Synchronization and Host 
Reconnections to execute automatically at the desired time. It is recommended that they 
occur once each day, during non-circulation hours.

For an explanation of Checkout Cache Synchronization, see “Synchronizing the Checkout 
Cache” on page 2-8. You should schedule this task to occur once each day.

Host reconnection refers to re-establishing the Application Server’s connection with the 
Library Management System. Various tasks that the LMS performs (such as backup) can 
cause it to close its connection to the Application Server. You should schedule the 
reconnection to happen after the LMS performs these types of tasks. 

To display the Task Scheduler and schedule the tasks:

Figure 2.9 Task Scheduler Navigation
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1 Select Maintenance > Task Scheduler.

Figure 2.10 Task Scheduler Menu

2 In the ILS Task Scheduler window, click View Current Schedule or Modify Current 
Schedule, depending on which task you want to perform. View Current Schedule does 
not allow you to change the schedule.

3 Type the ILS username and password in the ILS Login window. The default 
username is ils and the default password is maint. 

4 Click OK to log in to the Task Scheduler. The Task Scheduler window displays:

Figure 2.11 Task Scheduler dialog box (Modify)

5 In the ILS Task Scheduler dialog box, enter the following information:

a Type a Task ID number. Valid Task ID numbers are:
3200 = Checkout Cache Synchronization
3201 = Host Reconnect
3401 = Transaction Purge (marks for deletion records older than 14 days in 

Transaction database)
3402 = Transaction Compact (deletes marked records in Transaction database)
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b Click the Disable Task checkbox to override the scheduled time that the task 
should run. The task will not run until you clear the checkbox.

c Enter a name for the task.
d Select whether the task should be run Weekly/Daily or Monthly.

If you select Monthly, enter the day of the month on which the task should run.
e For each day of the week that you want the task to run, enter a time to start the task. 

If you do not want the task to run on a particular day, leave that day’s time field 
empty or clear it, as needed.

Note Be sure to schedule Checkout Cache Synchronization to occur soon after the checkout cache file is 
transferred from the LMS to the Application Server by the library staff.

You can scroll to different tasks using the arrows at the bottom of the window.

f To save your changes, click Save, then click Close at the bottom of the dialog box. 
To ignore changes, click Cancel.

Synchronizing the Checkout Cache 
Under normal conditions, you schedule the Checkout Cache to synchronize automatically. 
However, Field Service personnel may ask you to perform this task manually or they may 
perform the task themselves.

Checkout cache synchronization works as follows:

1 Each night, the library staff generates a list of item identifiers of checked-out material 
from the LMS. The library staff transfers this checkout cache file to the C:\inetpub\
ftproot directory on the Application Server.

2 Checkout Cache Synchronization should be scheduled to occur after the checkout 
cache file is transferred to the Application Server. 

3 When the Checkout Cache synchronizes, the Application Server deletes its own, older 
version of the checkout cache file, and uses the newly transferred file as its new 
checkout cache file.

To manually synchronize the Checkout Cache:

1 If have not already done, transfer the latest checkout cache file from the LMS to the 
Application Server. 

Figure 2.12 Synchronize Checkout Cache

2 From the menu, select Maintenance > Checkout Cache > Synchronize.
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3 Type a user name and password in the ILS Login dialog box and click OK. The 
default username is ils and the default password is maint. The Checkout Cache 
Synchronize window displays.

Figure 2.13 Checkout Cache file location

4 In the Checkout Cache Synchronize window, navigate to and select the checkout cache 
file (the one that was downloaded from the LMS), usually located at c:\InetPub\
FTPRoot. The name of the file is customizable for each library.

5 Click Open to start the synchronization.
When Checkout Synchronization begins, a “cache synchronization in progress” 
message displays. 

Figure 2.14 Cache synchronization in progress message

A message displays when the process is successfully completed.

Figure 2.15 Cache synchronization complete message
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Downloading Inventory from the Portable Reader
Downloading inventory information is a two-step process. First, you download the 
information from the Portable Inventory Reader to the Intelligent Library Controller. Then 
the Intelligent Library Controller converts the information to the inventory file format 
used by the LMS and copies it to a directory from which the LMS accesses it (using FTP). 

To download inventory information from the Portable Inventory Reader to the Intelligent 
Library Controller:

1 Dock the Portable Data Terminal in its docking station. Inventory transfer begins 
immediately.

Figure 2.16 Portable Reader Operations Screen - Automatic Transfer

2 Once complete, click Close to close the window. The inventory file is now ready to be 
uploaded by the LMS.
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Generating Reports
This section describes the ILS reports provided by the Intelligent Library Controller and 
gives instructions for generating them. Available reports include:

• Checkout Discrepancy Report
Use this report only if your site allows off-line processing. This report lists off-line 
checkout events that were rejected by the LMS after it returned to on-line processing. 
See “Checkout Discrepancy Report” on page 2-14.

• Patron Discrepancy Report
Use this report only if your site allows off-line processing. This report lists off-line 
patron status events that were rejected by the LMS after it returned to on-line 
processing. Before you can successfully generate this report, you must use the Offline 
Synchronize function (see “Synchronize Offline Transactions” on page 13-3) to move 
off-line transactions into the transaction database. See “Patron Discrepancy Report” on 
page 2-15.

• Generic Reports
You specify this report’s parameters to create custom reports. See “Generic Reports” 
on page 2-18.

• Exit Alarm Report
This report lists items that caused an alarm at specified exits. See “Exit Alarm Report” 
on page 2-21.

• Check In Report
This report lists items that failed to check in or that require special handling. See 
“Check In Report” on page 2-23.

After generating a report, you can view or print it. If you generate a report for a specific 
branch, you can save, view, or print it; or view later from an ILS Remote Monitor at 
another location. You cannot generate Intelligent Library Controller reports when using 
ILS Remote Monitor. See “Using ILS Remote Monitor” on page 5-8 for further details.

You can navigate to the most commonly requested reports (Checkout Discrepancy, Patron 
Discrepancy, and Exit Alarm) by using the buttons on the button bar, as well as the 
Reports menu.
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Specifying a Time Period for Any Report
You can specify a time period in one of three ways: 

• “Choose a Time Period”
• “Use the Calendar”
• “Enter the From and To information” yourself

Choose a Time Period
1 Choose the time period by using the drop-down list labelled Time Period of Interest. 

Choices include: Today, Yesterday, This Week, Last Week, This Month, Last Month, 
and All Data.

2 Enter a From and To time, or leave the fields blank to accept the default times:
From = 12:00:00 A.M.
To = 11:59:59 P.M.

Figure 2.17 Time Period fields
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Use the Calendar
1 Click From (or To) to display the calendar form.

Figure 2.18 Calendar

1 Select the month and year from the drop-down lists.
2 Select the day from the calendar table.
3 Specify the time. Enter the time yourself, or select the time by pressing the up-down 

arrow buttons at the end of the field. Click Now to use the current time.
4 Click OK.

Enter the From and To information
In the From and To fields, enter the date and time yourself. Valid date and time 
formats include:

Date: MM/DD/YY or MM/DD/YYYY
Time: HH:MM AM or PM
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Checkout Discrepancy Report
Use this report only if your site allows off-line processing. This report lists off-line 
checkout events that were rejected by the LMS after it returned to on-line processing. 
Before you can successfully generate this report, you must use the Offline Synchronize 
function (see “Synchronize Offline Transactions” on page 13-3) to move off-line 
transactions into the transaction database. 

When the LMS returns on-line, use the Offline Synchronize function (see “Synchronize 
Offline Transactions” on page 13-3) to move off-line transactions into the transaction 
database.

To generate the Checkout Discrepancy Report:

1 In the Intelligent Library System Control window, select Reports > Checkout 
Discrepancy, or click the Checkout Discrepancy Report button. 

Figure 2.19 Checkout Discrepancy List window

2 In the Specific Report: Checkout Discrepancy List window, enter the time period for 
which to run the report. See “Specifying a Time Period for Any Report” on page 2-12 
for details on the different ways to enter time criteria.

3 If desired, enter the Item ID of the specific item for which you are searching for which 
you are searching.

4 If desired, restrict the report to a specific branch by selecting that branch in the Branch 
drop-down list box. If selected, you will have the ability to save the report for viewing/
printing in ILS Remote Monitor.
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5 Click Generate Report. The report displays.

Figure 2.20 Sample Checkout Discrepancy Report

6 Resolve any discrepancies using the Library Management System. 

Patron Discrepancy Report
Use this report only if your site allows off-line processing. This report lists off-line patron 
status events that were rejected by the LMS after it returned to on-line processing. Before 
you can successfully generate this report, you must use the Offline Synchronize function 
(see “Synchronize Offline Transactions” on page 13-3) to move off-line transactions into 
the transaction database. 

To generate the Patron Discrepancy Report:

1 When the LMS returns to an on-line state, use the Offline Synchronize function (see 
“Synchronize Offline Transactions” on page 13-3) to move off-line transactions into 
the transaction database.

The Checkout Discrepancy Report contains the following fields.

Table 2.1 Checkout Discrepancy Report Field Names and Data Description

Field Name Possible 
Field Data

Data Description

Branch Name of branch The branch at which the discrepancy occurred.

Patron Identifier ID Number The patron ID number in this transaction.

Transaction Date Date/Time Date and time of the transaction.

Item Identifier ID Number The item number in this transaction.

Title Book title Book title.

Station Name Name of Station Station where the transaction occurred.

Final Transaction Date Date/Time The date and time that an off-line incomplete transaction was synchronized.

Screen Message Text Message Message returned from the LMS for this transaction.
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2 In the Intelligent Library System Control window, select Reports > Patron Status 
Discrepancy, or click the Patron Discrepancy Report button. The Patron Status 
Discrepancy window displays:

Figure 2.21 Patron Status Discrepancy List window

3 In the Specific Report: Patron Discrepancy List window, enter the time period for 
which to run the report. See “Specifying a Time Period for Any Report” on page 2-12 
for details on the different ways to enter time criteria.

4 If desired, enter the Patron ID for which you are searching.
5 If desired, restrict the report to a specific branch by selecting that branch in the Branch 

drop-down list box. If selected, you will have the ability to save the report for viewing/
printing in ILS Remote Monitor.

6 Click Generate Report. The report displays.

Figure 2.22 Sample Patron Discrepancy Report 
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7 Resolve any discrepancies using the Library Management System.
The Patron Discrepancy Report contains the following fields.

Table 2.2 Patron Discrepancy Report Field Names and Descriptions

Field Name Possible Field Data Data Description
Branch Name of branch The branch at which the discrepancy occurred.

Patron Identifier ID Number The patron ID number in this transaction.

Transaction Date Date/Time Date and time of the transaction.

Station Name Name of Station Station where the transaction occurred.

Final Transaction Date Date/Time The date and time that an off-line incomplete transaction was synchronized.

Screen Message Text Message Message returned from the LMS for this transaction.
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Generic Reports
The Intelligent Library Controller stores all activity, such as patron validation, checkout, 
check-in, and exit alarms, as a transaction. You can generate custom reports from these 
activities, which list specific transactions and transaction counts. 

To generate a Generic Report:

1 In the Intelligent Library System Control window, select Reports > Generic Report. 
The Generic Report window displays:

Figure 2.23 Generic Report window

2 In the Transaction Coordinator Report Generator window, enter the time period for 
which to run the report. This is the only required field. See “Specifying a Time Period 
for Any Report” on page 2-12 for details on the different ways to enter time criteria.

3 In the drop-down lists, select:
a A particular Self-Checkout Station, or keep the default All Stations.
b A particular type of transaction, or keep the default All Types. Choices include: 

Check In, Check Out, Patron Status, or Item Information.
c The type of processing, or keep the default Both Online/Offline.
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d The type of report to generate (list or count), or keep the default All Transactions 
List. Choices include: All Transactions Count, Discrepancy Count, Discrepancy 
List, Failed Transaction Count, Failed Transaction List, Successful Transaction 
Count, and Successful Transaction List.

4 If desired, enter the Patron ID for which you are searching.
5 If desired, enter the Item ID for which you are searching.
6 If desired, restrict the report to a specific branch by selecting that branch in the Branch 

drop-down list box. If selected, you will have the ability to save the report for viewing/
printing in ILS Remote Monitor.

7 Click Generate. The report displays.

Figure 2.24 Sample Generic Report
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The Generic Report contains the following fields.

8 You can view the reports on the screen, print them, or return to the previous screen. 

Table 2.3 User Specified - Report for All Transaction List Field Names and Descriptions

Field Name Possible Field Data Data Description
Branch Branch Name of the branch.

Transaction date Date/Time Date and time of the transaction.

Station Name Name of Interrogator Name of the interrogator where the transaction occurred.

Status Completed The transaction was successfully completed on-line.

Offline-Complete The transaction was an off-line incomplete transaction that was 
subsequently successfully completed online during off-line 
synchronization.

Offline-Incomplete The transaction was not completed on-line.

Discrepancy The transaction was an off-line incomplete transaction that was 
subsequently rejected during off-line synchronization.

OffLine-OnLine Offline Transaction completed off-line.

Online Transaction completed on-line to the LMS.

Transaction Type Patron Status Patron scans their ID card at a Patron Self-Checkout Station. 

Checkin An item automatically checked in to the LMS.

Checkout An item is scanned at the Patron Self-Checkout Station.

ItemStatus An item is scanned at the circulation desk.

ExitAlarm An item generated an alarm at an exit because it was not checked out.

Final Transaction Date Date/Time The date and time that an off-line incomplete transaction was synchronized.

Item Identifier ID Number The item number in this transaction.

Patron Identifier ID Number The patron ID numbers in this transaction.

Item Status Checked Out The item is checked out.

Checked In The item is checked in.

Status Unavailable The item’s status is unknown.
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Exit Alarm Report
This report lists items that caused an alarm at specified exits.

To generate an Exit Alarm Report:

1 In the Intelligent Library System Control window, select Reports > Exit Alarm, or 
click on the Exit Alarm Report button. The Exit Alarm Report window displays:

Figure 2.25 Exit Alarm Report window

2 In the Specific Report: Exit Alarm Report window, enter the time period for which to 
run the report. See “Specifying a Time Period for Any Report” on page 2-12 for details 
on the different ways to enter time criteria.

3 If desired, restrict the report to a specific branch by selecting that branch in the Branch 
drop-down list box. If selected, you will have the ability to save the report for viewing/
printing in ILS Remote Monitor.
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4 Click Generate Report. The report displays:

Figure 2.26 Sample Exit Alarm Report 

The Generic Report contains the following fields.

Table 2.4 Exit Alarm Report Field Names and Descriptions

Field Name Possible Field Data Data Description
Transaction date Date/Time Date and time of transaction

Item Identifier ID Number The item number in this transaction

Book Title Book title Name of the book.

Branch Name of branch The branch at which the discrepancy occurred.

Exit Location Name of the exit and/or IP Address Name of the exit
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Check In Report
This report lists items that failed to check-in or that require special handling. 

To generate the Check In Report:

1 In the Intelligent Library System Control window, select Reports > Check In. The 
Check In Report window displays:

Figure 2.27 Check In Report window

2 In the Specific Report: Check In Report window, enter the time period for which to 
run the report. See “Specifying a Time Period for Any Report” on page 2-12 for details 
on the different ways to enter time criteria.

3 If desired, select a particular check-in station, or keep the default All available.
4 If desired, restrict the report to a specific branch by selecting that branch in the Branch 

drop-down list box. If selected, you will have the ability to save the report for viewing/
printing in ILS Remote Monitor.
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5 Click Generate Report. The report displays:

Figure 2.28 Sample Check In Report

The Check In Report contains the following fields.

Table 2.5 Check In Report Field Names and Descriptions

Field Name Possible Field Data Data Description
Branch Name of branch Name of branch at which check-in occurred

Transaction Date Date/Time Date and time of the transaction.

Check-in Location Name of location Location of the check-in station.

Item ID ID Number The item identifier number in this transaction.

Title Item title Title of the item checked-in.

Location Name of location Location of check-in.

Checked-In Y Item was checked in

N Item was not checked-in.

OFFLine-Online OffLine Transaction completed off-line.

OnLine Transaction completed on-line to the LMS.

Alert Y An exit alarm was issued.

N An exit alarm was not issued.

Screen Message Text of Message The specific error message received from the LMS for this transaction.
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Working with the Bridge Interface
The Bridge Interface allows libraries with non-supported circulation vendors, or no LMS 
at all, to use the ILS security and Staff Station reader features. Self-Checkout Stations are 
not available when using Bridge mode.

You can change the operation mode of the Staff Station Readers programmed as a tag pad 
to either check-in or checkout materials during normal operations. You can also group 
individual tag pads together so that you can quickly change a group to either check-in or 
checkout personalities.

Changing the Op Mode of a Staff Station Reader
In Bridge mode, you can change the function of the Staff Station Reader to become either 
a check-in or checkout device.

Figure 2.29 Bridge Mode

1 On the Intelligent Library Controller in the Interrogator Status area, select a Staff 
Station Reader. The description should indicate if the device is a Staff Station Reader 
(tag pad).

2 In the Operation Selection field, select either Check In or Check Out, as desired.
3 Click Set Mode. The Staff Station Reader highlighted changes its Op Mode, from 

either Check In to Check Out or vice versa, which you verify in the Op Mode column.
4 Click Save to save your changes.
5 Repeat the procedure to change the personality back.

Creating Staff Station Reader Groups
Staff Station Readers can be grouped together so that you can quickly change the 
personality for a group of Staff Station Readers to either check-in or checkout.

1 On the Intelligent Library Controller in the Interrogator Status area, select a Staff 
Station Reader.
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2 Click Edit. The Edit Interrogator window displays.

Figure 2.30 Edit Interrogator Window

3 Type a Group number in the Group number dialog box.
4 Click Save.
5 Close the window using the top right-hand corner X.
6 Click Save on the main window to save your changes.
7 Repeat step 2 through step 6 for each Staff Station Reader you wish to assign to a 

group. You can create multiple groups.

Changing the Op Mode of Multiple Staff Station Readers
Once you have assigned multiple Staff Station Readers to a group number (accomplished 
at “Creating Staff Station Reader Groups”), you can now alter the check-in or checkout 
personality of a group with one operation.

1 On the Intelligent Library Controller in the Operation Selection area, select the 
function desired, either Check In or Check Out.

2 From the drop-down menu next to Operation Selection, select the Group number 
desired, for example all Staff Station Readers in Group 1.

3 Click Set Mode. All the Staff Station Readers in Group 1 change to reflect the new 
check-in or checkout personality selected.

4 Click Save to save your changes.

Maintenance
See “Intelligent Library Controller System Maintenance” on page 13-1 for information on 
maintaining the Application Server.
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Display System Information
To display copyright and version information about ILS:

1 In the Intelligent Library System Control window, select Help > About ILS.

Figure 2.31 Help About Navigation

2 Click System Info to see a detailed listing of all components and their versions.

Figure 2.32 Help About ILS window
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Notes
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C H A P T E R

CHAPTER 0PATRON SELF-CHECKOUT STATION
The Self-Checkout Station enables library patrons to check out library materials without 
the assistance of library staff. The Self-Checkout Station guides patrons smoothly through 
the checkout process with step-by-step instructions to assist in checking out materials 
properly. The process is quick, efficient, and (if available) delivers a printed receipt listing 
the checked out materials and their due dates.

The Self-Checkout Station delivers data, item identification and its checkout status, to the 
Library Management System, which processes the information and updates the library 
records. The processing occurs almost instantaneously, allowing a speedy and efficient 
checkout.

 Note: The Self-Checkout Station is the same as the CheckStation II.

Overview
There are three steps to checking out library material:

• “Presenting a Patron ID Card, Step 1” - Identify yourself with your library card 
• “Scanning Items for Checkout, Step 2” - Check out materials
• “Finishing Checkout, Step 3” - Finish and collect your receipt (if available)
The windows on the Self-Checkout Station reflect this order, showing Step 1, Step 2, and 
Step 3, identifying the checkout process.

The following pages details the process a patron uses to check out library material.

 Note: The sample windows shown in this chapter may differ slightly than the windows shown on your 
library’s Self-Checkout Station. Your library may have a different Self-Checkout Station model, 
operating environment, welcome logo, or other windows.
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Beginning a Self-Checkout Station Session
If the Self-Checkout Station is configured to use multiple languages, the first window 
shown is the ILS multiple language welcome window.

Figure 3.1 ILS Multiple Language Welcome window

If configured to use a single language, the first window shown is the ILS single language 
welcome window.

Figure 3.2 ILS Single Language Welcome window

1 Touch the screen or select a language to begin the checkout process.
• Some libraries support multiple institutions. If so, you are presented with a multiple 

institution selection window in which you select the correct institution.
2 After you have removed your finger, the image changes to the Patron Identification 

window.
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Presenting a Patron ID Card, Step 1
Have your patron ID card ready and follow the instructions shown on the window, seen 
here.

Figure 3.3 Patron Identification window

1 On the right side of the window, you are given visual instructions on how to present 
your patron ID card for authorization. Your ID card may be different than the type of 
ID card illustrated in the sample Patron Identification window; if so, simply follow the 
visual instructions on the Patron Identification window specific to your institution. 

2 If you have been authorized to check out items, the Item Entry window is displayed.
3 If your site uses the optional CheckPASS feature that allows library patrons to pay 

library fees at a Self-Checkout Station, and if you owe fees to the library, you are 
prohibited from checking out library material until the fee is paid. See “CheckPASS” 
on page 11-1 for details.
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4 If you have not been authorized, the Patron Identification Failure window appears.

Figure 3.4 Patron Identification Failure window

Contact the librarian desk for further assistance. After a short period the Welcome window 
is displayed again allowing normal checkout procedure.
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Scanning Items for Checkout, Step 2
Once authorized for checkout, the window advances and instructions appear on how to 
check out each item. On the left side of the window, the patron’s name displays at the top. 
Once you have checked out items, a list of those items displays as shown in the Items 
Identification window - Item List shown below.

Figure 3.5 Item Identification window - Begin

1 Take one (or more) of the items you wish to check out and slowly pass it over the 
surface area of the item identification pad. You do not need to slide it on the pad in 
order for the item to be identified. Simply move the item over the pad in a smooth 
fashion, about 4 inches (10 cm) above the pad area.
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2 Repeat the above step for each item you want to check out. As you pass the item over 
the pad, the system identifies each item and lists it on the left side of the window. Some 
institutions may provide additional information along with the item name.

Figure 3.6 Items Identification window - Item List

At anytime in the checkout process you may touch Done to complete your checkout 
session. The Done button is on the right bottom of the window.
If you have checked out more items than can display on the window, the list 
automatically scrolls to show the most recent items at the top of the list. To see items 
that have already scrolled off the bottom of the list, touch the Down Arrow. Press the 
Up Arrow to see the most recent items checked out.

Figure 3.7 Items Identification window - Scroll

3 Press Done to end your session.
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Viewing Items that Could Not be Checked Out
If any item you tried to check out is not accepted, a message appears indicating the system 
was unable to process the item. Listed are the title (if available) of the item and the reason 
for denied access. If the title is not available, No Match appears next to Title. 

Figure 3.8 Item Identification window - Failure

If numerous items have been rejected so that all cannot be fully displayed on the left, a 
scroll bar appears to the right of the list. To see items that have already scrolled off the 
bottom of the list, touch the Down Arrow. Press the Up Arrow to see the most recent 
items.

Contact your librarian for assistance with items that were not successfully checked out. 
You may continue with the check out of additional items by returning to the Item 
Identification window. 

Press Continue to continue your session.
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Finishing Checkout, Step 3
The Step 3 window displays when you have finished checking out all your items and 
touched Done. The window instructs you to collect your printed receipt and shows you the 
total number of items checked out. 

Figure 3.9 End Session window

Collect the printed receipt from the receipt dispenser. Your receipt lists the items you have 
checked out as well as the return due date for each item. 

 Note: Some institutions may not provide a printed receipt.

Loading Roll Paper
When the paper runs low or out, follow these directions for replacing the roll paper for the 
Self-Checkout Station’s printer.
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1 Remove the printer cover on the Self-Checkout Station. 

Figure 3.10 Paper Roll Release

2 Press the paper roll release lever to the front of the unit and swing the paper guide up 
and away from the printer.

Figure 3.11 Insert Paper

3 Remove the empty roll and lower in the new roll, with the paper facing the correct 
direction.

Paper Roll 
Release Lever

Insert paper in 
this direction.

Do not insert paper 
in this direction.
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4 Pull the paper out a bit, as seen below in Figure 3.12, “Lower the Paper Guide.”

Figure 3.12 Lower the Paper Guide

5 Rotate the paper guide back down until you position the guide in between the main roll 
and the paper fed underneath the paper guide.

6 Once the paper guide clicks into place, the paper cutter should activate and partially cut 
the paper. If not, then reseat the paper guide again. If the cutter still fails to activate, 
reboot the Self-Checkout Station and try again.

Powering On the Self-Checkout Station
The following procedure powers on a Self-Checkout Station:

Figure 3.13 Turning On the Self-Checkout Station

1 On the back panel of the Self-Checkout Station, flip on the power switch.
2 The Self-Checkout Station starts, logs in, and launches the CheckPC program 

automatically.

Power On/Off Switch
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Powering Off the Self-Checkout Station
The following procedure shuts down a Self-Checkout Station using CheckVIEW:

1 Launch CheckVIEW on the library staff’s computer by clicking Start > Programs > 
Checkpoint Systems > CheckVIEW Monitor from the library staff’s computer. 

2 Access the specific Self-Checkout Station by selecting View from the menu and then 
select one of the Display (1-4) options for the desired Self-Checkout Station.

3 On the keyboard, press CTRL + SHIFT + DEL. 
4 Click Shut down. The Self-Checkout Station enters a shut down sequence until it 

states that Self-Checkout Station can be turned off. 

Figure 3.14 Turning Off the Self-Checkout Station

5 Go to the Self-Checkout Station and turn off the power switch.

Power On/Off Switch
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Notes
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C H A P T E R

CHAPTER 0PORTABLE INVENTORY READER

Overview
The Portable Inventory Reader is an easy-to-use wireless long range reader that changes 
how library staff take inventory. The Portable Inventory Reader combines convenience 
with versatility, using a lightweight, handheld portable data terminal connected to an 
extendable inventory wand. This makes it easy to read items in hard-to-reach areas, and, 
because of the sophisticated antenna design and electronics, the Portable Inventory Reader 
becomes a very long-range reader. This is very useful for taking inventory or trying to 
locate materials that have not been shelved properly. 

The Portable Inventory Reader consists of two units:

• An inventory wand
• A portable data terminal 
The handheld inventory wand, using a built-in antenna to scan for circulation circuits, 
connects to a Portable Data Terminal (PDT), which stores the information retrieved from 
and accessed by the wand. The PDT enables data to be uploaded or downloaded from the 
Intelligent Library Controller, providing both inventory and searching capability.

The Portable Inventory Reader enables a fast, efficient and accurate method for taking 
inventory of library materials.

Figure 4.1 Portable Inventory Reader

Inventory Wand

Portable Data Terminal
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Inventory Wand LED Indicators
The inventory wand uses three LED lights: 

Figure 4.2 Wand LED Indicators

Table 4.1 Wand LED Indicators

LED Description
Green The power is on

Red Circulation circuit is being read

Yellow Low battery condition

Green

Red
Yellow
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Charging the Inventory Wand Battery
Prior to using the inventory wand for any significant inventory collection or inventory 
search session, ensure that its battery is fully charged to guarantee that the entire collection 
is inventoried all at once. 

Figure 4.3 Extracting Inventory Wand battery

To extract the battery from the inventory wand:

1 Rotate the inventory wand so that the antenna is facing away from you as shown in 
“Extracting Inventory Wand battery”.

2 Press the tab in the middle of the battery and lift it carefully upwards.
3 Once disconnected, rotate the battery until you see the power connection jack. 

Figure 4.4 Inventory Wand power plug connection

4 Using the cable from the battery charger, connect the battery to the battery charger and 
plug the adapter into an outlet to begin charging. The estimated charging time is 4 to 6 
hours.

Press here and lift 
the battery upwards

Connect power 
plug here
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There is an LED indicator on the battery charger that indicates when the battery is 
completely charged. 

5 When charging completes, disconnect the power plug. Insert the front of the battery 
(with the tab) first into the wand’s battery receptacle, then rotate the back of battery 
down until it clicks into place. 

Maintaining the Portable Data Terminal
This section details how to charge and turn on and off the portable data terminal.

Charging the Portable Data Terminal
Before using your terminal for the first time, charge the battery fully using the CRD 2800 
cradle or synchronization cable. Your terminal is equipped with a memory backup battery 
that automatically charges from the main lithium-ion battery. This backup battery retains 
data in memory when the terminal's battery is removed, and takes several hours to charge 
when you first use your terminal.

 Note: If you remove your lithium-ion battery before the backup battery is fully charged, data may be lost. 
For this reason DO NOT remove the battery within the first ten hours of use.

When battery voltage is low, a warning message displays indicating the battery needs to 
be charged.

There are two methods to charging the PDT:

1 Using the Serial Charging Cable
2 Using the Universal Cable Cup

Using the Serial Charging Cable to charge the battery
1 Insert the cable into the bottom of the terminal.

Figure 4.5 Insert Synchronization Cable

*

.

Serial Charging 
Cable
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2 Plug the power cable into a wall outlet and plug the other end into the battery charging 
receptacle on the side of the synchronization cable.

Figure 4.6 Battery charging with serial charging cable

Using the Universal Cable Cup to charge the battery
To charge the battery using the Universal Cable Cup:

1 On the cable cup, ensure the locking tabs are in the open position (up).
2 Insert the PDT into the cable cup.
3 Press down on the two locking tabs.

Figure 4.7 Insert PDT into cable cup

4 Lightly pull on the cable cup to ensure that it is securely attached to the terminal.

*

.
Serial Charging 
Cable

Locking Tabs
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5 Open the rubber cap covering the power port.

Figure 4.8 Connecting power cable

6 Plug the power connector into the power port. The battery is fully charged after 
approximately 2 1/2 hours.

Powering On and Off the Portable Data Terminal
1 To turn on the PDT, press the red power button on the lower left-hand side of the 

terminal to turn on the unit.

Figure 4.9 Powering On the Portable Data Terminal

 Note: When not using the Portable Data Terminal within a set amount of time, the device enters a Power 
Save mode, meaning the device powers down. To turn it back on press the red power button. You 
are returned to the last window presented prior to shut off.

2 To turn off the unit, press and hold the power button until the screen turns grey, then 
press the power again.

Rubber Cap

*

.

Power Button
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Using the Portable Data Terminal
In this chapter the word tap is used instead of click because the stylus supplied is used to 
tap the touch screen. There are no double-clicks on the Portable Data Terminal unit as all 
actions are accomplished by a single tap. The stylus is stored in a silo on the back of the 
Portable Data Terminal. 

Please refer to the Symbol Portable Data Terminal Series Quick Reference Guide for 
more information regarding use of this device.

Turning On/Off Backlight
Use the key combinations below to adjust the backlight.

Figure 4.10 Backlight On/Off

The backlight turns off after a configurable amount of time. 

 Note: You can alter the setting in Start > Settings > System > Backlight.

Checking the Status of the Batteries
It may become necessary to check the status of the Portable Data Terminal’s battery 
power. Use the following procedure:

1 Tap the Start icon in the upper left hand corner of the window.
2 Tap the Settings menu item.

Table 4.1 Remote User Manager Access Privileges
Keys Description
Press and hold Turns the display backlight and keypad backlight on and off.

When both backlights (display and keypad) are off, the backlights 
turn on in the following order when the button is held:
• First the display backlight turns on, continue to hold, then the 

keypad backlight turns on.
• When either backlight is on, the backlights turn off when the 

power button is pressed and held.
Press + Decrease display backlight (decrease brightness).

Press + Increase display backlight (increase brightness).

*

.

Function Key

Alphanumeric Keys

Scroll Keys

Power Button

Alpha Key

Enter Key
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3 Tap the System tab at the bottom of the Settings Panel window.

Figure 4.11 Settings Window

4 Tap the Power icon. The Battery Status window displays. This window shows you the 
power status of both the main and the backup batteries. 

Figure 4.12 Battery Status
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A warning displays if either battery is low. 

Figure 4.13 Low Battery Warning
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Performing a Reset
If your PDT stops responding to input from buttons or the screen, reset it by performing a 
soft or hard reset. Only perform a hard reset if a soft reset fails to clear the problem.

Performing a Soft Reset
A soft reset restarts the terminal and saves all stored records and entries.

Caution Files that remain open during a warm boot may not be retained. DO NOT perform a soft reset if the 
terminal is suspended. Press the power button to wake the terminal.

Figure 4.14 Soft reset buttons

To perform a soft reset, press and keys while holding down either the left or 
right scan trigger and then releasing the keys.
The unit resets, during which the display shows a startup screen.

Performing a Hard Reset
A hard reset restarts your Portable Data Terminal terminal and erases all stored records 
and entries, including any extra programs installed in the Main Memory such as the ILS 
Inventory program. Therefore, never perform a hard reset unless a soft reset does not solve 
your problem.

 Note: You can restore any data previously synchronized with your computer during the next ActiveSync 
operation.

Caution: With a hard reset, the current date and time, formats, preferences, and other settings are restored to 
their factory default settings.

To perform a hard reset:

1 Remove the hand strap above the locking screw by sliding the end of the strap towards 
the bottom of the unit.

Figure 4.15 Locking screw

Right Scan 
Trigger

Locking Screw
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2 Turn the locking screw counterclockwise until the cover releases from the terminal and 
lift the battery door away from the terminal.

3 While holding down the button, use the tip of the stylus (or similar object without 
a sharp tip) to gently press the Reset button.

4 Release the button.
5 Replace the battery cover and hand strap and press the button. As the terminal 

initializes its unique Flash File system, the Symbol splash screen displays for about a 
minute.

6 Follow the prompts when Aligning the Screen appears to perform an initial setup of 
the terminal.

Reset Button



4-12 I L S  O p e n  P l u s  3 . 0  I n s t a l l a t i o n  M a n u a l

Collecting Inventory Data
Now that the Portable Data Terminal has been initialized, you are ready to begin 
collecting inventory information.

1 Connect the synchronization cable from the inventory wand to the Portable Data 
Terminal.

Figure 4.16 Attaching Synchronization Cable to Portable Data Terminal

2 Turn on the Portable Data Terminal by pressing the red button in the lower-left hand 
corner of the device.

Figure 4.17 Powering On the Portable Data Terminal

Synchronization 
Cable

*

.

*

.

Power Button
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Once you have powered on the Portable Data Terminal, you are presented with the ILS 
Inventory main menu window.

Figure 4.18 ILS Inventory Main window

 Note: If you do not see the main ILS Inventory window, tap the Start button in the upper-left hand corner of 
the screen. Tap on the ILS Inventory menu item in the start menu to launch the program.

3 Tap Inventory Collection located in the center of the screen. 

Figure 4.19 Inventory Collection

4 Tap Start located in the bottom-left hand corner of the screen. 
5 If a previous inventory collection file was not transferred to the ILS Server, you will be 

asked if you want to add (append) to the file. 
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• Selecting Yes continues the previous inventory collection and new items are added 
to the file. 

• If you select No, you are asked to confirm that you do not wish to keep the existing 
data. Tap OK if sure and a new inventory file is created. Tap Cancel to append to 
the file (as if you had selected Yes). 

• If you want to transfer the previous file after selecting Yes, you can immediately tap 
Done to initiate a file transfer.

6 Begin scanning for items.

Figure 4.20 Scanning Books

Hold the wand in your hand about three inches (7 cm) from the material you wish to 
scan. Notice that the red light on the wand blinks, indicating that the wand is detecting 
circulation circuits. The wand detects Circulation Circuits up to a distance of 8 inches 
(20 cm); therefore, it is important to keep the wand focused on the intended inventory 
items to avoid unwanted data from being collected.

3-8 in
7-20cm
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Alternatively, you can use the barcode scanner of the PDT to scan for barcodes. Press 
either the left or right scan trigger button to activate the barcode scanner, which beams 
from the front of the PDT.

Figure 4.21 Inventory Collection In Progress

Once you begin scanning, the following information displays in the ILS Inventory 
screen:
• Most recently scanned items

The bar code number for that circuit displays on the Portable Data Terminal in the 
Most Recently Scanned Items field. 

• Items Read
Field displays the total number of inventory tags read over time. 

• Available Memory
Field displays the percentage of memory still available.

7 Once completed scanning, tap Done. See “Transferring Inventory Data” on page 4-16 
for instructions on data transfer.
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Transferring Inventory Data 
Once you complete scanning inventory, follow these instructions to transfer the data. 

1 After you have finished collecting inventory by tapping Done, a dialog window 
displays asking if you want to transfer the data collected. Tap OK to do so.

 Note: If you wish to continue the inventory collection after you have pressed Done, press Cancel to 
prevent file transfer and re-enter inventory collection mode.

2 Unplug the cable from the bottom of the Portable Data Terminal. 
3 Dock the Portable Data Terminal into the cradle. A Transferring window displays on 

the Portable Data Terminal while data is transferring to the Intelligent Library 
Controller.

Figure 4.22 Portable Interrogator Operations

4 Once the transfer is completed, the Intelligent Library Controller displays the Portable 
Inventory Reader Operations window. The inventory you transferred is converted by 
the Intelligent Library Controller to a text file containing the list of barcodes. The file 
name and location is displayed in the Transfer Status Display window. When the 
process is finished, click Close on the Portable Interrogator Operations window. 

The Intelligent Library Controller then converts the information to the inventory file 
format used by the LMS and copies it to a directory from which the LMS can copy it 
(using FTP).

5 The Portable Data Terminal displays Transfer Complete. Tap OK to return to the ILS 
Inventory Main window. 

You may begin another inventory collection by selecting Start. Or, exit to the main 
window by clicking OK found at the top-right of the screen.
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Searching the Inventory
Use this function to search for missing or desired materials. Library material must have a 
circulation circuit attached to it for this function to succeed. Also, it is helpful if scanning 
for more than one item that you prepare an Item Search List file before searching. 

Preparing an Item Search List File
An Item Search List file contains the barcodes you wish to find. The file uses the .psl file 
extension and can be created:

• By formatting a report from the circulation system 
• By formatting an Inventory Search or Shelf Order Search file conducted with the 

Portable Reader
• Using a text editor (like Notepad) to manually enter item information
Create the file in the following manner:

1 Gather your barcode data of missing items. If you have conducted an Inventory Search, 
you can use this file by changing the extension to “.psl” and following the formatting 
identified in step 2. 
If you are producing a report from your circulation system, ensure that it follows the 
parameters explained in the step 2.

2 Enter the data by typing or copying and pasting the data into a simple text editor, like 
Notepad, shown in the figure below: “Sample PSL File”. 
• The barcode numbers must be in a single row, with a return at the end of each line. 
• If you wish the call number and book title to appear associated with that barcode, 

you must separate the information with a pipe symbol “|”. 
• You can also have just a call number or just a book title appear as well with the 

associated barcode. If you want just a Book Title to appear with that barcode, you 
must include two pipes sequentially to account for the empty call title column.

If your data resides in a more complex spreadsheet program like Microsoft Excel®, it is 
not recommended that you copy the data from Excel and paste it into your text editor as 
the correct pipe symbol is not used to separate data. However, you can manually alter 
the file if you choose to paste the data from a spreadsheet.

Figure 4.23 Sample PSL File

3 Once the data is entered, save with a descriptive name and close the file. Note the 
location where you saved the file.

Barcode only
Barcode with Call #

Barcode with Call # and Book Title
Barcode with only Book Title
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4 Navigate to the location of your file and change the extension of the file to PSL. For 
example, “Item Search.txt” becomes “Item Search.psl”. 

Figure 4.24 PSL File Name Change

The next section informs you how to transfer this file to the Portable Data Terminal using 
the docking station.

Transferring the Search List File
To transfer a search list file (or files) from the Intelligent Library Controller to your 
Portable Data Terminal

1 Place the search file (for example, Item Search.psl) in the synchronization directory for 
your Portable Data Terminal. There should be a shortcut to this directory on the 
desktop of the Intelligent Library Controller. 

2 Once the file is in the correct location, dock the Portable Data Terminal and the file(s) 
is automatically transferred. 

3 Once the file(s) has been transferred remove the Portable Data Terminal from its 
cradle.

4 If ILS Inventory is not running on your Portable Data Terminal, launch the program by 
tapping the Start button in the upper-left hand corner of the screen, then tap ILS 
Inventory.
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Importing the Search List File
To import the search list file:

1 From the main screen of ILS Inventory, tap Item Search. The Item Search window 
displays.

Figure 4.25 Search List File

2 Follow either instruction for importing barcodes:
a If you are searching for a single barcode, you can input the number directly into the 

Item Search Barcode field. Tap Add when finished and the barcode number appears 
below. 
The name of the search result file is stated in the Result File field (for example, 
“search2.*” in the example above) unless you use the Save As to enter a different 
name. See “Saving Custom Search Files” on page 4-34 for details.
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b If you have created a search file, tap Import. The Import window displays.

Figure 4.26 Search File Import

c Ensure that Item Search List Files (*.psl) is selected as the type, using the down 
arrow at right to select the type of file displayed. Your search file appears below in 
the Name field (the example shows “Item Search” already highlighted). 

d Tap the file name (for example, you would tap Item Search, shown above), and the 
file imports automatically. If the import is successful, you are returned to the Item 
Search window. If unsuccessful, double-check that the format of the file is a plain 
text file that uses the extension *.psl. See “Preparing an Item Search List File” on 
page 4-17 for more details about preparing the file.
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3 In the Item Search window, the Barcodes field displays the barcodes that will be used 
in searching for items.

Figure 4.27 Item Search Input

If you need to move or delete a particular barcode, highlight it and select the 
appropriate action at right.

4 Tap OK. You see the ILS Inventory window.

Figure 4.28 Inventory Search

5 Tap Start to begin your inventory search.
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Scanning for Inventory
There are several ways to view information on the Search Mode window. 

• View 1 - Items Found
Indicates all of the barcodes that were found.

• View 2 - Items Not Found
Indicates all of the barcodes that the system has not yet found.

• View 3 - Show All Items
Shows both the Items Found and the Items Not Yet Found. This is the default 
selection. 

• Alerts Enabled
When the Alerts enabled is selected, an alert displays and sound occurs for each 
item found. The search mechanism stops temporarily, allowing you to locate the 
item found on the shelf. To disable this feature, tap it.

1 Tap a different view at any time to change.
2 Use the inventory wand to scan for barcodes, sweeping back and forth. See “Scanning 

Books” on page 4-14 for a details. 
Notice that the barcode display field(s) reflects changes in the status of the search 
items, depending on the search option you chose. Items found (the field above) are 
listed as you find them. Items not found (the field below) are removed from the list as 
you find them.

Figure 4.29 Item Search window

Notice that the red light on the wand flickers when it finds circulation circuits. It is 
important to keep the wand focused on the intended inventory items to avoid unwanted 
data from being collected.



P o r t a b l e  I n v e n t o r y  R e a d e r :  S e a r c h i n g  t h e  I n v e n t o r y  4-23

 Note: While the red light may flash when the scanner detects any tag, a barcode only displays in the Items 
found list if it matches an item present in your Search Items list.

3 When a barcode is found; the barcode, shelf location, and title of the item (if all 
configured in your search file) display. Retrieve the item, if necessary, and tap 
Continue to resume the search.

Figure 4.30 Item Found Alert

4 When finished, tap Done at the bottom of the screen. If all of the items are found, an 
alert window notifies you. 

Figure 4.31 All Items Found
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5 Tap OK to continue and the Item Search result files are generated. 
A dialog box displays asking you to dock the Portable Data Terminal to transfer the 
Search Results file.

Figure 4.32 Portable Data Terminal Docking

6 Tap OK and place the Portable Data Terminal into the docking station to begin the 
transfer. 

 Note: In Wireless mode the file transfer is automatic. If you would like to abort the file transfer, tap Cancel. 
You are returned to the Item Search window.

The Search Results files are transferred to the configured directory on the Intelligent 
Library Controller. Refer to “Transferring Inventory Data” on page 4-16 for details. 

Figure 4.33 Sample search results directory

The “PPTSearchRst.txt” file lists all of the barcodes searched. If a barcode was found, 
the date and time of the search are listed. If the barcode was not found, the date and 
time are not listed.
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Two additional files are also created to list the items found and the items not found. 
• The Items Found file uses the file extension *.psf. 
• The Items Not Found file uses the file extension *.psm. 
These files may be used to perform another search, or may be processed as results of 
the search on the circulation system.
Every time you upload the results of an Item Search, the search results file 
“PPTSearchRst.txt” is overwritten with the new data automatically. Thus, if you wish 
to retain the previous data, save the file elsewhere before synchronizing.

Conducting Shelf Order Search
Use Shelf Order Search to verify the contents of a shelf against a shelf order list generated 
by the Library Management System. Items scanned are compared to the shelf order list to 
determine if they are in order, not in the list, or not found. This enables verification and 
sorting of the shelf contents. 

Selecting or Creating a Shelf Order Search File
A Shelf Order Search file is identified by a *.pso file extension and is transferred from the 
Intelligent Library Controller to the Portable Data Terminal. To select or create a Shelf 
Order file:

1 Create the file by running a Shelf Order report on the circulation system or by creating 
a Shelf Order file manually. 

2 See “Preparing an Item Search List File” on page 4-17 for details on how to format the 
file, as you configure the file using the exact same methodology as in preparing a 
Search List file, only you use the “.pso” extension when saving the file. 

Transferring the Shelf Order File
To transfer a Shelf Order file:

1 To transfer a shelf order file (or files) from the Intelligent Library Controller to your 
Portable Data Terminal, place the file (for example, Shelf Order.pso) in the 
synchronization directory for your Portable Data Terminal. There should be a shortcut 
to this directory on the desktop of the Intelligent Library Controller. 

2 Once the file is in the correct location, dock the Portable Data Terminal and the file is 
automatically transferred. 

3 Once the file(s) has been transferred, remove the Portable Data Terminal from its 
cradle.

4 If ILS Inventory is not running on your Portable Data Terminal, launch the program by 
tapping the Start button in the upper-left hand corner of the screen, then tap ILS 
Inventory.
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Importing Shelf Order File
To import a Shelf Order file:

1 From the main screen of ILS Inventory, tap Shelf Order. The Shelf Order window 
displays.

Figure 4.34 Shelf Order Window

2 Follow either instruction for importing a shelf order list:
a If you are checking a single barcode, you can input the number directly into the 

Shelf Order Barcode field. Tap Add when finished and the barcode number appears 
below. 
The name of the search result file is stated in the Result File field (for example, 
“sorder1.*” in the example above) unless you use the Save As to enter a different 
name. See “Saving Custom Search Files” on page 4-34 for details.
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b If you have created a shelf order search file, tap Import. The Import window 
displays.

Figure 4.35 Search File Import

c Ensure that Shelf Order List Files (*.pso) is selected as the type, using the down 
arrow at right to select the type of file displayed. Your search file appears below in 
the Name field (the example shows “shelf order” already highlighted). 

d Tap the file name (for example, you would tap shelf order, shown above), and the 
file imports automatically. If the import is successful, you are returned to the Shelf 
Order Barcode window. If unsuccessful, double-check that the format of the file is a 
plain text file that uses the extension *.pso. See “Preparing an Item Search List 
File” on page 4-17 for more details about preparing the file.



4-28 I L S  O p e n  P l u s  3 . 0  I n s t a l l a t i o n  M a n u a l

3 In the Shelf Order Barcode window, the Barcodes field displays the barcodes that are 
used in searching for items.

Figure 4.36 Item Search Input

If you need to move or delete a particular barcode, highlight it and select the 
appropriate action at right.

4 Tap OK. You are taken to the ILS Inventory window.

Figure 4.37 Shelf Order Start
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Shelf Order Search Window
The Shelf Order Search window displays the following information:

Figure 4.38 Shelf Order Searching

• Items in file
The original count of the items read from the Shelf Order file.

• Items Read
The number of items read during the search.

• Items in order
The number of items that were read in shelf order.

• Items not in order
The number of items that were read that are not in shelf order.

• Offset in use
Adjust the offset by changing the number and tapping Set. 
This indicates the current setting used to determine how many barcodes can be 
separated (or offset) before they are considered out of shelf order. So in the example 
above, a barcode would be considered out of order if found separated by 10 barcodes. 
An offset is needed because the wand can read items in a random order within its read 
range, allowing for adjustment when items of different thickness are being scanned. 
For example, poetry books are usually slim while reference books are much thicker, 
thus allowing more or less books within the read range of the inventory wand.
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• Alerts Enabled
When checked, an alert displays and a sound occurs for items of interest. Tap this 
button to disable alerts. Alerts occur for the following reasons:

See “Shelf Order Alert” on page 4-30 for more details.
5 Tap Start to begin your inventory search. You must scan items at the starting shelf 

location in the list. The Offset in use and the Alerts enabled settings may be changed at 
any time during the search. 

6 When finished, tap Done. If all of the items shelf order list are found, an alert window 
notifies you. Tap OK to continue. See “Shelf Order Results” on page 4-31 for details 
on what to do next.

Shelf Order Alert
When a Shelf Order Alert displays for an item that:

• Is not in the list, the barcode displays. The Item Status field indicates Not in List. 
• Is not in shelf order, the barcode, shelf location, and title displays. The Item Status field 

indicates Out of Range. 

Figure 4.39 Shelf Order Alert - Out of Range/Not in List

• Show Prev
Displays the previous item read. You can tap this button to display the last item in 
order to assist in locating the item on the shelf. 

Out of range • The item read was found in the Shelf Order list, but was not located close 
enough to the last item in the shelf order.

Not in list • The item read was not found in the Shelf Order list.
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• If Not in List, this item should probably be removed from the shelf, since it is not in 
the shelf order list. 

• If Out of Range, this item should be repositioned on the shelf in the correct order.
• Show Next

Displays the next item read.
• Show Item

Returns the display to the item that is not in the list.
Tap Continue when you are ready to resume the scan. Be sure to start at the position you 
were in when the alert occurred.

“Offset in use” and “Alert enable” settings may be changed once the search is resumed.

Shelf Order Results
When the shelf order search is completed, the Shelf Order Results window is displayed. 
The Shelf order results window shows the counters from the completed search. 

From the results you can:

• Create a new search list
• Create files of various types from each of the items with results
• View the results of each items
Notice that there is no prompt to perform file transfer at this point because you need to 
specify the type of file you wish to transfer. Once the file has been created, you would then 
dock the Portable Data Terminal to copy the file to the Application Server. 

Figure 4.40 Shelf Order Results
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Creating a New Search List
1 Tap on the item of interest in the Shelf order results field. For example, “Items not in 

file.” Items in file does not generate a file.
2 Tap New Search List.
3 If a result is present, the File Created field automatically populates with the file name 

of the Shelf Order Search file and the correct extension “.psl”. For example, if the 
“Items not in file” line is selected, a new search could be performed to locate the items 
that do not belong on the shelf: 

Figure 4.41 PSL file

The next time you dock the Portable Data Terminal, the file created is uploaded to the 
Intelligent Library Controller.

4 Tap Done.
5 You may now import this file to scan for the barcode(s) into Item Search. See 

“Preparing an Item Search List File” on page 4-17 for more details.

Creating a File from Shelf Order Results
This creates a new Search Order Result file, based on which counter is selected in the 
Shelf order results window. The file extension used determines the type of file, explained 
below:

1 Tap on the item of interest in the Shelf order results field. For example, “Items not in 
file.” Items in file does not generate a file.

2 Tap Create File and the file is created. The File Created field automatically populates 
with the file name of the Shelf Order Search file and the correct extension. For 
example, if the “Items not in file” line is selected, the extension of “.pnl” is used: 

Figure 4.42 PNL file

Table 4.2 Search Order Results

Item Description

Items in file The original count of the items in the Shelf Order file. (no file is created.)

Items in order The number of items that were read in shelf order. (.pio)

Items out of 
order

The number of items that were read that are not in shelf order. (.poo)

Items not 
found

The number of items in the Shelf Order file that were not found. (.pmi)

Items not in 
file

The number of items read that were not in the Shelf Order file. (.pnl)
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3 You may now import this file to scan for the barcode(s) into Item Search. See 
“Preparing an Item Search List File” on page 4-17 for more details.

Viewing Shelf Order Results
View List displays the results of a Shelf Order scan. Each item read is displayed in order, 
with the appropriate status information.

Figure 4.43 Shelf Order View List window

1 Tap on the item of interest. For example, “Items in order.” The View List window 
appears.

2 Tap View List.
3 Tap Show Prev. and Show Next to step through the list.
4 Tap Done when finished. You are returned to the Shelf Order window.
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Saving Custom Search Files
When you create customized search files on the Portable Data Terminal, either types of 
Item Searches or types of Shelf Order Searches, you can save the customized lists with a 
file name you input. The same directions apply for all types of search files.

1 From either the Item Search or Shelf Order main windows, tap Save As. The Save As 
window displays.

Figure 4.44 Sample File Save As Window

2 Enter a descriptive name into the Name field.
3 Select a folder, if desired, to save the file. Your synchronization folder is the default 

folder (None) already selected.
4 Select the Type of file you wish to create.
5 You do not need to alter the location from Main Memory.
6 Tap OK to save the file.
To retrieve your file:

1 Tap Start > File Explorer. 
2 Navigate to My Documents to find your file. Or, dock the Portable Data Terminal to 

upload your file to the Application Server.
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C H A P T E R

CHAPTER 0ILS REMOTE MONITOR
This chapter describes the ILS Remote Monitor utility and provides information on how 
to:

• Install web site certificates on the clients (page 5-2)
• Set up and manage user accounts and permissions (page 5-5)
• Start up ILS Remote Monitor (page 5-8)

• Single server, multi-branch environment
• Peer-to-peer environment

• Change branch views (page 5-9)
• View the status of different branches (page 5-10)
• View and print reports (page 5-11)
• Upload Portable Inventory Reader inventory files (page 5-12)
ILS Remote Monitor is an optional utility that allows library staff operating in a single 
server, multi-branch or peer-to-peer environment to view the status of other branches on 
the network from any computer on that network. In addition, library staff can:

• Monitor exit alarms
• Identify problematic Patron Self-Checkout Stations
• Print pre-run reports
• Transfer files from a remote location to the Application Server
After ILS Remote Monitor is installed and configured on the Application Server, any 
computer on the local network can use ILS Remote Monitor to access Intelligent Library 
Controller information.
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Installing Web Site Certificate on a Client Computer
To establish a secure channel between the client computer and the Application Server, you 
must install web site certificates on both the server and the client. You must renew the 
server certificate yearly; you must install the client certificate only once, on each computer 
on which you want to use ILS Remote Monitor.

Checkpoint Field Service personnel install the server certificates for you. You install the 
client certificates. 

You must install the certificate.cer client certificate onto each computer on which you 
want to use ILS Remote Monitor. This establishes a secure channel between the client 
computer and the Application Server.

To install the client certificate:

1 Log on as a user with administrative rights to the client’s computer.
2 Copy the checkpoint.cer file from the Application Server at e:\rfid\utilities\

Checkpoint Systems\Intelligent Library Remote Monitor\ to the client computer’s 
desktop.

3 Navigate to the desktop checkpoint.cer and double-click the file. The Certificate 
window displays.

Figure 5.1 Certificate window

4 Click Install Certificate (Figure 5.1). The Certificate Import Wizard displays.
5 Click Next.
6 In the Certificate Store window, select Automatically select the certificate store 

based on the type of certificate. Click Next.
7 When the certificate installation is completed, click Finish.
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8 Click Yes to add the certificate to the Root Store.
9 Click OK to close all windows.
10 Repeat steps 1 through 8 on each client computer on which you want to use ILS 

Remote Monitor.

Verifying Successful Certificate Installation
Use the following procedure to check that the certificate is correctly installed:

1 Open a browser window.
2 Select Tools > Internet Options....

Figure 5.2 Internet Options window

3 Select the Content tab (Figure 5.2). 
4 Click Publishers....
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The Certificates window displays:

Figure 5.3 Certificates window

5 Select the Trusted Root Certification Authorities tab (Figure 5.3). Ensure that 
CheckPointSystems is included in the list.

6 If not, see “Installing Web Site Certificate on a Client Computer” on page 5-2. 
7 Close all windows.

Setting Hyperlink on Client’s Computer
This procedure indicates how to create a bookmark hyperlink on a client’s computer, so 
that the user can easily access ILS Remote Monitor.

1 On the client’s computer, launch Internet Explorer.
2 In the URL bar, type https://<machine name of server>/ils/ and press Enter. For 

example, https://rfidserver/ils/.
3 Once the home page of ILS Remote Monitor loads, click Favorites > Add to 

Favorites....
4 Click OK to accept the default Name. The bookmark is now saved and accessible with 

the Favorites menu.
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Setting Up and Managing User Accounts
The Remote User Manager utility lets you create and manage accounts that provide 
access to the ILS Remote Monitor. The utility also lets you unlock accounts that have been 
disabled as a result of incorrect username-password combinations.

Table 5.1 lists the access privileges you can assign to each user:

Users assigned the Remote Console access privilege see only the features they are 
empowered to use. Users assigned Remote Report, Administrator, or Customer Service 
access privileges see all ILS Remote Monitor features. 

Adding a User Account
Take the following steps to add a user account to provide access to the ILS Remote 
Monitor:

1 In the Intelligent Library System Control window, select Maintenance > Remote 
User Manager (Figure 5.4). 

Figure 5.4 Select Remote User Manager

2 Log on as ILSRemote, password remote123. 
3 Click Add (Figure 5.5).
4 Type a user name and password.

Table 5.1 Remote User Manager Access Privileges
Access Privilege Description
Remote Console View status of any or all branches.
Remote Report Access all ILS Remote Monitor functions: view status, view and 

print reports, upload inventory files.
Administrator Access all ILS Remote Monitor functions: view status, view and 

print reports, upload inventory files. Access Application Server 
operations. 

Customer Service Access all ILS Remote Monitor functions: view status, view and 
print reports, upload inventory files. Access Application Server 
operations. 
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Figure 5.5 Remote User Manager Access Levels

Select the Access Level privilege for the user (Figure 5.5). 

Use only the first two selections for this setting.
5 Click Save.

Modifying a User Account
Take the following steps to modify an existing ILS Remote Monitor account:

1 In the Intelligent Library System Control window, select Maintenance > Remote 
User Manager. 

2 Log on as Customer Service, user name of ils and password of maint.
3 Select the user name to be modified.
4 Make the necessary changes.
5 Click Save. 

Table 5.2 Access Level
Access Level Permission description Login
Remote Console View-only, cannot upload files, view 

reports
User: ILSRemote
Password: remote123

Remote Report Full Control, can upload files User: ILSReport
Password: report123

Administrator (Library 
IT)

Full Control, can upload files User: ils
Password: maint

Customer Service 
(Checkpoint Field 
Service)

Full Control, can upload files User: xxxxx
Password: xxxxx
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Removing a User Account
Perform the following steps to delete an existing ILS Remote Monitor account:

1 In the Intelligent Library System Control window, select Maintenance > Remote 
User Manager. 

2 Log on as Customer Service, user name of ils and password of maint.

Figure 5.6 Remove User Account

3 Select the user name to be deleted (Figure 5.6).
4 Click Remove. 
5 At the prompt, click Yes.

Unlocking a Locked Account
If an ILS Remote Monitor user enters an incorrect user name and password combination 
three times, that user is prevented from logging on again until the account is unlocked in 
the Remote User Manager.

Take the following steps to unlock a disabled user account:

1 In the Intelligent Library System Control window, select Maintenance > Remote 
User Manager. 

2 Log on as Customer Service, user name of ils and password of maint.
3 Select the user name.
4 Deselect the Account Locked check box. 
5 Click Save. 
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Using ILS Remote Monitor
With the exception of starting up ILS Remote Monitor, the utility functions the same way 
in both single server, multi-branch and peer-to-peer environments. To start up ILS Remote 
Monitor, follow the instructions appropriate to your site’s environment.

Launching ILS Remote Monitor in a Single Server, 
Multi-Branch Environment 
To launch ILS Remote Monitor in a single server, multi-branch environment:

1 Open a browser window.
2 Type http://<machine name of server>/ils in the address bar and press Enter. 

Optionally, use the saved bookmark in your Favorites menu.
3 Enter your ILS Remote Monitor user name and password. The ILS Remote Monitor 

utility displays (Figure 5.7).

Figure 5.7 ILS Remote Monitor main window
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Using ILS Remote Monitor in a Peer-to-Peer Environment 
ILS Remote Monitor enables you to determine the status of different servers in a 
peer-to-peer environment. Depending upon the URL you enter, you can different view 
peer servers in your network.

• To view information for your own branch, enter your branch’s server name of the 
peer server in the browser’s address bar (example: https://rfidpeer1/ils).

• To view information for the other branches in the peer-to-peer environment, enter 
the server name of the peer servers in the browser window’s address bar (example: 
https://rfidpeer2/ils).

1 Open a browser window.
2 To see information for your local branch, type https://<machine name of server>/ils 

in the address field, where machine name is the name of your Peer server. To see 
information for another branch in the peer-to-peer environment, substitute that 
branch’s peer server name in the address bar. For example: https://rfidpeer1/ils/.

3 Press Enter.
4 Enter your ILS Remote Monitor user name and password. The ILS Remote Monitor 

utility displays (Figure 5.7).

Changing Branch Views
To view information for a different branch:

1 Click the Branch tab.

Figure 5.8 Select Branch

2 Click Select beside the branch whose information you want to view (Figure 5.8).
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Viewing Status
The Status page lists the information of the currently selected Branch and all the 
components connected to the server. The following components’s health (status) can be 
monitored:

• Self-Checkout Stations
• Library Management System connection
• Interrogators
• Alarms

To view the status of a branch, click on the Status tab. 

This is the default view. To change to a different branch, see “Changing Branch 
Views” on page 5-9.
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Viewing and Printing Reports
Reports cannot be generated by using ILS Remote Monitor to log in to the Application 
Server. You can only generate reports from the Application Server, and then once 
generated, view those reports with ILS Remote Monitor.

To view pre-run reports for a selected branch:

1 Click the Reports tab.

Figure 5.9 View Reports

2 To view the report, click the desired report name (Figure 5.9). When viewing a report, 
you can return to the list of reports by clicking the Reports tab.

3 To print a report, use the browser’s Print feature. To see all the data, print reports in 
Landscape orientation. (In Internet Explorer, select File > Page Setup... and select 
Landscape orientation.)

4 To delete a report, click Delete Report beside the report name.
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Uploading Portable Inventory Reader inventory files
To upload a Portable Inventory Reader inventory file to the Application Server:

1 Click the Inventory tab.

Figure 5.10 Upload Inventory 

2 Enter the inventory file name, or click Browse to navigate to the inventory file (Figure 
5.10).

3 Click Upload Inventory.

Logging out
To log out of ILS Remote Monitor:

1 Click the Logout tab. You will be logged out and have to log back in to use the utility. 
2 See “Using ILS Remote Monitor” on page 5-8 for instructions on logging in to ILS 

Remote Monitor.
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C H A P T E R

CHAPTER 0EXCEPTION TICKET PRINTER
This chapter explains the function of the exception ticket printer, and provides instructions 
for using the printer. This feature is optional; your site may not use the exception ticket 
printer.

The chapter covers the following topics:

• Introduction (page 6-1)
• Printer layout (page 6-2)
• Using the exception ticket printer (page 6-3)
• Setting the printer’s cut type (page 6-4)
• Inserting paper (page 6-5)
• Running a Self-Test on the exception ticket printer (page 6-6)
• Installing the cover (page 6-6)
• Error codes (page 6-7)
• Troubleshooting (page 6-8)
• Removing jammed paper (page 6-8)
• Cleaning the print head (page 6-9)
• Printer specifications (page 6-9)

Introduction
The exception ticket printer is usually located near the library’s book drop, and its sole 
function is to print a receipt when incoming library material has been placed “on hold” by 
the Library Management System. This receipt can then be placed in the library material by 
library staff, to ensure that the material is directed to the appropriate location, instead of 
being returned to circulation. 

One exception ticket printer can service multiple interrogators. This means that a receipt 
might print at the exception ticket printer near Drop Box A for a book that is returned at 
Drop Box B. As a result, you may have to search more than one drop box to find the 
library material that matches the receipt.
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Printer Layout
Figure 6.1 and Figure 6.2 show the layout of the printer and its back panel.

Figure 6.1 Top of Printer

Figure 6.2 Printer Back Panel
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Control Panel

Using the Exception Ticket Printer
If the Library Management System has placed a “hold” on a particular book (or other 
piece of library material), the check-in of that material triggers the exception ticket printer 
to print a receipt. 

1 Periodically check the exception ticket printer for receipts. 
2 Retrieve the receipts and place them in the designated library materials that have been 

recently checked in. If an exception ticket printer is servicing multiple interrogators, 
you may have to search more than one drop box to find the library material that 
matches the receipt. 

3 Follow your site’s procedures for handling “on hold” materials. 

Power LED: The POWER light is on when the printer is on.

Error LED: Indicates an error. 

Paper Out LED: On indicates a paper near end or out. Flashing indicates standby.

Feed button: This button feeds paper or starts a self-test.
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Setting the Printer’s Cut Type
Checkpoint Systems recommends that you set up the printer to do a partial cut of the 
paper. This produces a string of receipts, which can be easily separated, rather than 
individual receipts, which might fall and be lost.

1 On the computer you used to set up the printer, click Start > Settings > Printers and 
right-mouse click the Epson printer.

2 Select Printing Preferences.
3 Select the Paper/Quality tab.

Figure 6.3 Partial Cut Select

4 From the Paper Source drop-down menu, select Form[Partial cut]. This sets the 
printer to only partially cut the receipt.

5 Click OK to save your selection and close the window.
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Inserting Paper
Take the following steps to add paper to the exception ticket printer:

1 Be sure that the printer is not receiving data. Press the Cover Open button to open the 
cover.

2 If present, remove any used paper roll core. Insert the paper roll in the correct direction, 
as shown in Figure 6.4.

Figure 6.4 Insert Paper

3 Pull out a small amount of paper, as shown in Figure 6.5. Then close the cover and tear 
off the extra paper by pulling it toward the front of the printer.

Figure 6.5 Tear Paper
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Running a Self-Test
Follow these steps to run a self-test on the paper roll:

1 Be sure that the printer is off and that the printer cover is closed properly.
2 Hold down the Feed button and turn on the printer using the switch on the front of the 

printer. This may take some time, so continue holding the Feed button until it prints.
3 The self-test prints the printer settings and then prints the following:

If you want to continue SELF-TEST printing,

Please press the PAPER FEED button.

Cuts the paper, and pauses. (The Power Out light flashes.)
4 Press the Feed button to continue printing. The printer prints a pattern using the 

built-in character set.
5 The self-test automatically ends and cuts the paper after printing “*** completed ***.” 

The printer is ready to receive data as soon as it completes the self-test.
Note: To pause the self-test manually, press the Feed button. Press Feed again to continue the self-test.

Installing the Cover
There are two covers that can be used to protect the printer from unnecessary interaction: a 
power switch cover and a connector cover. Using these covers are optional, depending 
upon the needs of the library.

Installing a Power Switch Cover
Warning If an accident occurs with the power switch cover attached, unplug the power cord immediately. 

Continued use may cause fire or shock.

The enclosed power switch cover ensures that the power switch is 
not pressed accidentally. To use this cover:

1 Insert the lower end of the cover into the slot around the switch.
2 Rotate the cover upwards until it snaps into place.
3 To remove the cover, use a flat bladed screwdriver to lever the 

cover off.

Installing a Connector Cover
The connector cover protects your cables. To attach it:

1 First, connect all the cables. The connector cover has three possible 
cable exits: on the right, left, and back. Remove the tab for the exit 
you want to use by breaking it off with your fingers. 

Note: Once you remove a tab, you cannot replace it.

2 After removing the tab, also remove any protruding plastic, so that the edge is smooth 
and does not damage the cables.
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3 Position the two hooks on the connector cover so that they 
hook the printer case.

4 Rotate the connector cover into the printer until it clicks into 
place. 

To remove the connector cover:

1 Turn the printer over, insert a flathead screwdriver under one 
hook, and pry up the hook while lifting the connector cover. 
See the illustration on the right below. 

2 Repeat this step for the other side and remove the cover.

Error Codes
The Control Panel LED displays the following patterns when certain error conditions are 
met.

Attaching cover

Removing cover

LED Pattern Solution

Autocutter error Check for paper jam in the autocutter. If problem continues, contact 
Checkpoint field service.

Cover open error Close cover.

Memory or gate array 
error

Contact Checkpoint field service.

High voltage error Replace power supply unit. If problem continues, contact Checkpoint field 
service.

Low voltage error Replace power supply unit. If problem continues, contact Checkpoint field 
service.

CPU execution error Contact Checkpoint field service.

Internal circuit error Contact Checkpoint field service.

High head 
temperature error

If you exceed the printer duty cycle, the head overheats. When it cools, the 
error clears. If this error occurs and you have not been printing for very long, 
check that the ambient temperature is within “Specifications” on page 6-9.
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Troubleshooting
The following table lists solutions to issues that might arise.

Removing Jammed Paper
Caution Do not touch the print head because it can be very hot after printing.

Take the following steps to remove jammed paper from the printer:

1 Turn the printer off and press the Cover Open button.
2 Remove jammed paper, reinstall the roll, and close the cover.

Removing an Autocutter Jam
Follow these steps to remove paper jammed in the autocutter:

1 If paper is caught in the cutter and you cannot open the printer cover, open the cutter 
cover as shown on the left in Figure 6.6.

2 Turn the knob until you see a triangle in the opening, as shown on the right in Figure 
6.6. This returns the cutter blade to the normal position. There is a label near the cutter 
to assist you.

Figure 6.6 Removing an Autocutter Jam

3 Close the cutter cover.
4 Open the printer cover and remove the jammed paper.

Condition Solution

No lights on the 
control panel

Check the power supply cable connections and the power outlet.

ERROR light on (not 
flashing) with no 
printing

• If PAPER OUT is on, the paper roll is not installed or is near the end.
• If PAPER OUT is off, the printer cover is not closed properly.

ERROR light flashing 
with no printing (and 
no paper jam)

Printing stops if the head overheats and resumes when it cools. Turn the 
printer off, and after 10 seconds, back on.
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ADJUSTMENT:

TURN KNOBTURN KNOB

UNTIL YOU SEEUNTIL YOU SEE

TRIANGLE IN OPENINGTRIANGLE IN OPENING
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Cleaning the Print Head
Caution After printing, the print head can be very hot. Be careful not to touch it, and to let it cool before you 

clean it. Do not damage the print head by touching it with your fingers or any hard object.

Take the following steps to clean the print head:

1 Turn off the printer, open the paper roll cover, and clean the thermal elements of the 
print head with a cotton swab moistened with an alcohol solvent (ethanol, methanol, or 
IPA).

2 Checkpoint Systems recommends that you clean the thermal head periodically 
(generally every 3 months) to maintain receipt print quality.

Specifications
The following lists specifications regarding printing specifications.

Table 6.1 Printing Specifications

Item Description
Printing Methods Thermal line printing
Dot density 180 dpi × 180 dpi (dpi = dots per inch {25.4 mm})
Print width 2.83" {72 mm}, 512 dot positions
Characters per line Font A: 42; font B: 56 (default)
Character structure Font A: 12 × 24 (including 2-dot spacing)

Font B: 9 × 17 (including 2-dot spacing)
Character spacing 0.01" {0.28 mm} = 2 dots, default
Print direction Unidirectional with friction feed
Print speed High-speed mode

• 5.9"/sec. {150 mm/sec.} maximum
• 47.2 lps maximum at 1/8" feed
• 35.5 lps maximum at 1/6" feed (at 24 V, 82.4°F {28°C}, density level 1)
Low-power-consumption mode
• Approximately 16.5 lps at 1/6" feed
• Approximately 2.76"/s {70 mm/s}
Ladder bar code
• 1.7"/s {42 mm/s}

Paper-feed speed 5.9"/s {150 mm/s} continuous feeding
Character sets • alphanumeric: 95 characters

• international: 37 characters
• extended graphics: 128 characters × 8 pages (including a space page)

Table 6.2 Environmental Conditions

Item Description
Temperature range • Operating 41 to 113°F {5 to 45°C}

• Storage 14 to 122°F {–10 to 50°C}
Humidity range • Operating 10 to 90% RH

• Storage 10 to 90% RH
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C H A P T E R

CHAPTER 0CHECKVIEW
This chapter describes the CheckVIEW utility and provides instructions for:

• Using CheckVIEW (page 7-3)
• Reinstalling missing files (page 7-6)

• Uninstalling CheckVIEW (page 7-6)
• Using CheckVIEW to shut down a monitored Self-Checkout Station (page 7-6)
• Troubleshooting information (“CheckVIEW Troubleshooting” on page 12-9). 
The CheckVIEW utility enables library staff to remotely view up to four different 
Self-Checkout Station at one time. From any computer on the library’s network, staff 
members are able to see exactly what the patrons see as they use the Self-Checkout Station 
to checkout materials. This enables library staff to manage issues such as:

• Patrons who are having difficulty using the touch screen
• Stations that may have hardware or system problems
• Viewing the patrons’ checkout list to reconcile any discrepancies concerning 

availability
Staff members use their mouse and keyboard to assist patrons by assuming control of a 
specific Self-Checkout Station window to step a patron through a check out procedure.

There are two modes a library staff member can use to aid a patron, Monitor mode and 
Host mode. Monitor mode allows the staff member to watch up to four Self-Checkout 
Stations. Once a problem is identified, Host mode enables you to interact directly with a 
particular Self-Checkout Station and guide the patron.
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The VNC server application must be installed on every Self-Checkout Station that is to be 
monitored by the library staff’s computer. TCP/IP network connectivity to the 
Self-Checkout Stations is required for monitoring Self-Checkout Stations.

Figure 7.1 CheckVIEW Network Diagram

Staff Computer Requirements
The following are the minimum requirements for using CheckVIEW:

• Windows 2000 or XP
• 800 MHz Pentium III or equivalent processor
• 256 MB RAM
• 17 Inch Monitor
• Screen resolution of 1024x768
• Network Requirement of 100 MB Ethernet

Intranet
(High Speed LAN)

Computer running 
VNC Viewer in Monitor 
mode

Self-Checkout Station 
running CheckVIEW 

Self-Checkout Station 
running CheckVIEW 

Self-Checkout Station 
running CheckVIEW 

Self-Checkout Station 
running CheckVIEW
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Using CheckVIEW in Monitor Mode
To launch the CheckVIEW application, select Start > Programs > Checkpoint 
Systems > CheckVIEW Monitor from the library staff’s computer. The default main 
page appears in Monitor mode with up to four Self-Checkout Stations displayed.

Figure 7.2 Monitor mode from CheckVIEW

You can easily determine the status of up to four Self-Checkout Stations by looking at the 
CheckVIEW window. See below for instructions on how to assist a Self-Checkout Station.

Monitoring mode showing 
three active Self-Checkout 
displays.

This area is empty. A fourth 
Self-Checkout appears here 
when active.

Name of 
Self-Checkout
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Using CheckVIEW in Host Mode
To gain access to a specific Self-Checkout Station to assist a patron:

1 Select View from the menu.
2 Select one of the Display (1-4) options. You can also press Ctrl+1-4 using your 

keyboard to access a Self-Checkout Station. 
Access to the window is shared between the staff member and the patron. The 
Self-Checkout Station window reacts to the most recent command by either the patron 
or the staff member. 

Figure 7.3 Assist mode as seen from CheckVIEW

3 Assist the patron as necessary with your keyboard and mouse.
4 To return CheckVIEW to Monitor mode, select View > All or press Ctrl+A. 
5 To close the application, click the X in the upper right hand corner of the window or 

select View > Close.

Adding/Removing Self-Checkout Stations to CheckVIEW
A settings.xml file is configured to add or remove the Self-Checkout Stations. 

1 Launch Windows Explorer and navigate to C:\Program Files\Checkpoint 
Systems\CheckVIEW Monitor\.

2 Open the Settings.xml file with Notepad.
a Right-mouse click Settings.xml.
b Select Open With...  and choose Notepad from the list of programs.

Assist mode. The 
CheckVIEW computer is 
actively involved with the 
Self-Checkout Station.
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3 To add a Self-Checkout Station so that it displays in CheckVIEW, enter 1 where it 
states Enabled, next to Display Index. See Figure 7.4, “Self-Checkout Station 
Monitoring Enabled.” 

Figure 7.4 Self-Checkout Station Monitoring Enabled

 Note: Enable only those Self-Checkout Station you are going to actively view, otherwise the monitoring 
system slows down.

4 To remove a Self-Checkout Station from CheckVIEW, type a 0.

Figure 7.5 Self-Checkout Station Monitoring Disabled

5 Save your changes and close the Settings.xml file.
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Reinstalling Missing Files
Use the Repair function to reinstall missing or corrupt files, registry keys, and shortcuts.

1 Insert the CheckVIEW CD-ROM into the computer’s CD-ROM drive. If 
CheckVIEW is already installed, the Application Maintenance window displays.

Figure 7.6 Application Maintenance window

2 Click the Repair option button. Click Next.

Uninstalling CheckVIEW
Use the Remove function to uninstall CheckVIEW. 

1 Insert the CheckVIEW CD-ROM into the computer’s CD-ROM drive. If 
CheckVIEW is already installed, the Application Maintenance window displays 
(Figure 7.6).

2 Click the Remove option button. Click Next>.

Using CheckVIEW to Shut Down a Self-Checkout Station
The following procedure shuts down a Self-Checkout Station using CheckVIEW:

1 Launch CheckVIEW on the library staff’s computer by clicking Start > Programs > 
Checkpoint Systems > CheckVIEW Monitor from the library staff’s computer. 

2 Access the specific Self-Checkout Station by selecting View and then select one of the 
Display (1-4) options for the desired Self-Checkout Station.

3 On the keyboard, press CTRL + SHIFT + DEL. 
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4 Click Shut down. The Self-Checkout Station enters a shut down sequence until it 
states that Self-Checkout Station can be turned off. 

Figure 7.7 Self-Checkout Station On/Off Switch

5 Go to the Self-Checkout Station and turn off the power switch.
Note: See “Powering On the Self-Checkout Station” on page 3-10 for instructions about how to turn on the 

Self-Checkout Station.

Power On/Off Switch
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Notes
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C H A P T E R

CHAPTER 0AFFIXING TAGS
This chapter describes the different types of RFID tags and provides instructions for 
placing the appropriate circuit on books, CDs, audio material, and kit material.

For information on the Tag Programming Station, see “Using Tag Programming Station” 
on page 9-1.

Types of tags
Checkpoint Systems provides three types of tag. Choose the appropriate circuit for each 
type of media.

Standard tag: Can be used on books, CDs, DVDs, audio material, and tagging kits. 

Figure 8.1 Standard tag

Video Tag: Can be used on video cassettes.

Figure 8.2 Video tag
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• CD-DVD Content tag: Can be used on CDs and DVDs (aka hub tag).

Figure 8.3 CD-DVD Content tag

Applying Tags to Books
The following procedure outlines a method for staggering the placement of tags in treating 
printed materials. This procedure is recommended to obtain the highest level of 
performance with ILS Open Plus products. 

The procedure requires materials to be treated in shelf order, which maintains tag 
staggering for the materials when placed on the shelves. Tag staggering helps to ensure 
that the materials can be reliably scanned during inventory operations and increases the 
number of items that can be processed by staff station readers, patron self-checkout 
stations, and security gates.

The diagram below shows the pattern layout on a single book. In practice, only one tag is 
placed in a book, but each treatment of a book is a progression of the pattern, which 
repeats. 

In some cases, the book height will not support the placement of a tag at positions 2 or 3. 
In this scenario, the next logical placement in the progression of the pattern is used. For 
example, if the height of the printed material only allows 2 positions, then repeat the 2 
position pattern until the next printed material allows all positions.
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Use only Standard tags on books.

Figure 8.4 Book Tagging Procedure

1 Open printed material to the inside back cover.
2 Peel the backing from the tag.

Note: Metallic covers interfere with reading of the circuit. If the book has a metallic cover, photocopy or 
replace the cover. Or cut a 3” x 3” (7.6 cm x 7.6 cm) section from the back of the cover and place the 
tag in this section.

3 Place the tag in position 1; the lower inside corner of the printed material, leaving 
1.2cm (½”) clearance from the spine of the material and 1.9cm (3/4”) from the bottom 
of the material, as seen in the tag placement diagram above.

4 In the next printed material, place the tag in position 2. This is 1.2cm (½”) above the 
top of the tag in the first printed material at position 1, as shown in the tag placement 
diagram. The total distance from the bottom of the printed material to position 2 is 
8.2cm (3 1/4”).

5 In the next printed material, place the tag at position 3. This is 1.2cm (½”) above the 
top of the tag at position 2, as shown in the tag placement diagram. The total distance 
from the bottom of the printed material to position 3 is 14.6cm (5 3/4”).

6 This completes the treatment pattern, which is now repeated successively for all 
subsequent materials. 

Note Do not place the tag over an EAS tag.

1.2 cm 
(1/2”)

1.2 cm (1/2”)

1.2 cm
(1/2”)

1.9 cm
(3/4”)

8.2 cm
(3 1/4”)

14.6 cm
(5 3/4”)

Position 1

Position 2

Position 3
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Applying Tags to Video Cassettes
Use only Video tags on video cassettes.

To place tags on video cassettes:

1 Place the tag on the spine of the cassette, on the same side as the title label.
2 Place the cover label over the tag. You can print a barcode as part of the cover label.

Figure 8.5 Sample Placement of tags on a CD and a Video Cassette
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Applying tags to CDs and DVDs
You can use either CD-DVD Content tags or Standard tags on CDs and DVDs.

To place barcode labels on CDs
Place the second, peelable barcode label on the back of the CD case. See Figure 8.7.

Figure 8.6 Sample placement of a barcode label on a CD

To place tags on Jewel Case CD cases
This procedure only applies to jewel cases.

1 Disassemble the CD, and place the tag with the printed barcode cover label in the upper 
or lower left corner, near the spine. 

2 Reassemble the CD.
3 Place the second, peelable barcode label on the back of the CD case. See Figure 8.7.
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To place content tags on CDs and DVDs
This procedure explains how to correctly place the content circuits (aka hub tags) on CDs 
or DVDs. For precise placement on the center of the disc, use the CD/DVD labeling 
applicator (the blue arched tool). 

1 Move the applicator to a smooth surface, such as a tabletop, so that it slides easily.
2 Peel the backing off of the content circuit.
3 Place it upside down (adhesive side up) on the applicator.

Figure 8.7 Sample placement of a barcode label on a CD

4 Place the disc upside down (label-side down) on top of the content circuit and press 
firmly down until the applicator bends flat.

5 Remove the disc and press down around the entire content circuit with your finger until 
it lies smoothly on the disc.
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To place tags on DiscMate DVD cases
This procedure only applies to DVD cases. To place standard 2" x 2" tags on DiscMate 
DVD (single or double) cases:

1 If necessary, unlock the case. 
2 Open the DVD case.
3 Peel the backing from the tag.

Figure 8.8 Sample Placement of Label on a CD/DVD Case

4 On the inside the front of the case, place the tag into the very top right corner, as close 
to the spine and top of the case as possible. Make sure that the dot is farther away from 
the spine and top of the case, as seen above.

5 If desired, affix a library cover-label sticker over the tag.

 Note When re-inserting DVD covers, do not use original artwork that is made of cardboard weight stock. 
The thicker cover may not allow the DiscMate case to slide through the DiscMate opening properly, 
due to the material’s thickness. Original artwork should be scanned or copied onto regular (20 lb.) 
paper stock before putting under the dust jacket.

Dot
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To place tags on DiscMate CD cases:
To place standard 2” x 2” tags on DiscMate CD (single or double) cases:

1 If necessary, unlock the case. 
2 Open and flip the CD case over so that backside of it faces upward.  In this position, the 

CD retaining hub is facing downwards.
3 Remove the CD from the case’s retaining hub.
4 Peel the backing off of the tag.

Figure 8.9 Placement of tag on a CD Case

5 Lift the clear plastic film away from CD case and slide the tag underneath, into the very 
bottom corner, as close to the edges as possible. Position the dot on the circuit so that it 
points to the center of the case, as seen above.

6 If desired, affix a library cover-label sticker over the tag. 
 Note 1 When re-inserting CD covers, do not use original artwork that is made of cardboard weight stock. 

The thicker cover may not allow the DiscMate case to slide through the DiscMate opening properly, 
due to the material’s thickness. Original artwork should be scanned or copied onto regular (20 lb.) 
paper stock before putting under the dust jacket. It is okay if part of the RFID circuit extends to the 
center hub of the case.

 Note 2 A cover-label is available that covers both sides of the tag. The cover-label may be printed to give it 
the appearance of a property sticker. Please contact your account representative for more 
information on this product.

Dot

Circuit placed under clear film Circuit on the outside with case in up position
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Applying Tags to Audio Material
Use only Standard tags on audio material.

To place tags on Audio Cases with Tapes on only one inside 
section:
1 Place the tag on the inside front cover, centered horizontally and vertically.
2 Place the cover label over the tag. You can print a barcode as part of the cover label.

Figure 8.10 Sample Placement of tag and Label on Audio Material

To place tags on Audio Cases with Tapes on both inside 
sections:
1 Remove the card stock from the outside sleeve of the front cover.
2 Place the tag in the sleeve, against the box, and replace the card stock so it covers the 

tag.
3 If the card stock is metallic, photocopy the card stock, and replace the metallic card 

stock with the photocopy.

Applying Tags to Kits
Use only Standard tags on kit material. 

1 Place the tag on the outside of the bag, or on the most valuable library material in the 
kit.
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2 Place the cover label over the tag. You can print a barcode as part of the cover label.

Figure 8.11 Sample Placement of Tag and Label on Kit Material
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C H A P T E R

CHAPTER 0USING TAG PROGRAMMING STATION

Overview
The following procedure explains how to use Tag Programming Station (printer 
programmer) and the associated Tag Programming Application. 

Figure 9.1 Tag Programming Station

The Tag Programming Station programs all ISO-compliant tags for the library. The Tag 
Programming Station prints out a library label (tag) with the RFID chip already built into 
it, simplifying the library material tagging process. Once printed, library personnel peel 
the backing off of the tag and attaches it to the material in the approved location. See the 
Tagging Procedures document for details.

Libraries use the Tag Programming Station to program tags with the item identifier from 
the barcode when converting a retrospective library collection. Tags are also programmed 
when new materials are added to the collection. 

When adding a new item to the collection and programming the tag, the library can also 
print a barcode label on the tag. In many cases, libraries support the use of barcodes in 
addition to the RFID inventory tags, primarily for compatibility with other branch libraries 
still using barcodes. 

The equipment and files you need for this are:
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• Tag Programming Station
• Tag Programming Application
• Programming Station Computer with monitor, keyboard, and mouse
• Barcode scanner
• USB to Serial Converter (2 qty) or a Serial Port Board
• Eventually, an active network connection from the TPS computer to the Application 

Server

How it works
ISO-ready tags are programmed (encoded) with the item identifier used by the LMS using 
the Tag Programming Station. In an RFID-only environment, this would be all that a 
library would do to convert their restrospective collection for using RFID tags.

For those libraries that will continue to support barcodes as well as RFID (mainly for 
support with branches that have not been converted yet), the library can also print a 
barcode on the label at the same time when programming a tag, linking the same item 
identifier used by the barcode and the tag.

The high-level process by which tags are programmed is as follows:

1 Decide if you are programming new or existing materials:
• If programming new materials, the program creates a new item identifier. 
• If using existing barcodes, you will scan the barcode for the item identifier to be 

programmed to the tag.
2 The Tag Programming Station prints and programs the tag with the item identifier.
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Programming Procedure

New Material
Use this procedure to program tags for new material using Auto-Increment mode for use 
within the ILS system. 

1 On the Tag Programming Station computer, click Start > All Programs > 
Checkpoint Systems > ISO Tag Programming Station. The initial Tag 
Programming Application displays.

Figure 9.2 TPS Initial Choice
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2 Click Auto Increment. The Server Configuration window displays:

Figure 9.3 Server Configuration window

3 Type the name of the Application Server to which you will eventually upload the tag 
information; most likely it is RFIDSERVER.

4 Select the Connection Mode you will use. 
• If you are connecting to Application Server, select Online. Click Connect if you 

select this option to verify you have a live connection to the Application Server. A 
Connected should appear.

• If you are not connecting to Application Server, select Offline. You can connect at 
a later date to upload the programmed tag information.

5 Click Save, to save your choice, then Close. The Serial Port Configuration window 
displays.

 Note: If a format file has never been created, the Label Format Selection window appears. Contact your 
Checkpoint service personnel for assistance in this instance.

Figure 9.4 Port Selection window
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6 Select the COM port used for the Printer Port and click Save and Close.
7
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C H A P T E R

CHAPTER 0USING DISCMATE

Overview
DiscMate is an easy-to-use protection security solution for libraries’ electronic media. 

The DiscMate solution consists of two units:

• The Standard Unlocking Station
• The Intelligent Unlocking Station
The Standard Unlocking Station is a manual unit used by the library staff to check-in or 
checkout CD/DVD media. The Intelligent Unlocking Station is an automated unlocking 
unit that library patrons use at the Self-Checkout Station to checkout CD/DVD media 
without staff assistance.

Figure 10.1 DiscMate Products

Note: The Intelligent Unlocking Station meets North American regulatory approvals. The European 
regulatory approvals are not applicable at this time.

Standard Unlocking Station Intelligent Unlocking Station
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LEDs on the Intelligent Unlocking Station
The Intelligent Unlocking Station uses three LEDs to communicate information about the 
activity of the unlocking process.

Figure 10.2 Intelligent Unlocking Station LEDs

The LEDs are explained below:

Using the Standard Unlocking Station
The Standard Unlocking Station consists of a black base with a key at one side. The key 
allows you to secure the station so that it cannot be used to unlock cases without 
authorization.
1 If necessary, insert the key and turn to lower the locking bar.
2 Insert the long edge of the case with locked symbol (red rectangle) down into the slot 

and swipe evenly across.
3 Check the case to ensure that the red rectangle does not appear. If not, rotate the case 

around and swipe again. Your case is now unlocked.

Table 10.1 CD/DVD Report Detail

LED Name Description
Success Illuminates when the case is successfully unlocked.

Arm Illuminates when the case has been successfully inserted.

Power Illuminates when power has been turned on.

Arm

Power

Success
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Using the Intelligent Unlocking Station
The Intelligent Unlocking Station consists of a black base with LEDs and a slot at the front 
where you insert the case. The Intelligent Unlocking Station sits next to a Self-Checkout 
Station and performs the unlocking automatically.

Figure 10.3 Self-Checkout Station with the Intelligent Unlocking Station

Note: Do not place your electronic materials near the Intelligent Unlocking Station during the checkout 
process. The Intelligent Unlocking Station may read your materials before you are ready. Place your 
CD/DVDs on a table away from the Intelligent Unlocking Station before checking them out.

1 Follow the prompts on the Self-Checkout Station monitor to checkout materials.
2 When instructed, insert the case into the slot. You must insert the top of the case with 

the locked symbol (red rectangle) on the right hand side of the case. See “Intelligent 
Unlocking Station Case Insertion Diagram” on page 10-4 for more details.

3 Push the case all the way until it stops. The bottom light at left, the arming light, 
illuminates, indicating you have correctly inserted the case.

4 The Intelligent Unlocking Station accepts the case, unlocks it, and returns it. The top 
left light illuminates, indicating a successful unlocking procedure has occurred.

5 Once the case stops moving, remove the case from the Intelligent Unlocking Station. 
Your case is now unlocked.

3” 
7.5 cm
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Intelligent Unlocking Station Case Insertion Diagram
The following diagram illustrates the correct orientation for case insertion into the 
Intelligent Unlocking Station.

Figure 10.4 Case Insertion Diagram
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Linking Procedure
The DiscMate solution uses circulation circuits (RFID tags) to track electronic media 
within the Intelligent Library System Open Plus. Two tags can be used to maintain content 
validation: a security tag and a content tag. The security tag (sometimes known as the case 
tag) is the larger tag on the inside of the case that is read by the exit gates. The content tag 
(sometimes known as the hub tag) attaches directly to the disc around the inner ring of the 
disc, which in this procedure, is linked to the security tag. 

The linking procedure performs a dual purpose: to link the security and content tags 
together and to enter the security ID number into a database. The procedure creates a 
relationship between the contents of the case and the case itself, producing a single 
security ID number (Linked Set) that is utilized by the LMS. That security ID is stored in a 
database that verifies the check-in/checkout status of the electronic media upon checkout, 
and if applicable, whether the case requires unlocking.

The DiscMate solution is a flexible in handling the different implementation scenarios 
used by libraries. For example, one library might decide they will use barcodes on a case 
and a content tag on a CD/DVD. Another library might decide that they require the 
security tag and content tag on jewel and locking cases. The different situations are 
configured within the Circuit Linking Utility.

Configuring Hardware to Link Media
To run the Circuit Linking Utility, you need:

• Circulation Circuit Programmer computer
• 2 Barcode scanners
• Barcode scanner user manual
• Staff Station Reader configured as a tag pad
• Circuit Linking Utility program
• Gender changer, DB25 male to DB25 male adapter
• DB25 female to DB9 female adapter
• Keyboard Wedge cable, with one male and one female connector
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Circuit Linking Hardware Diagram
The following is a top down view of how the hardware is connected together. Ensure that 
all items are attached in this configuration before proceeding.

Figure 10.5 Circuit linking hardware diagram

Tag PadBarcode 
Scanner

Keyboard Wedge

DB25 Male to DB9 Female 
Serial Connector

Computer

COM4 COM3

Circulation 
Circuit 
Programmer

Barcode 
Scanner

Serial to 
USB 
Connector

Serial Cable
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Linking Electronic Media with Confirmation
Use this procedure to prepare individual CD/DVD media for use within the ILS system. 
Each time you link, a confirmation message appears. 

Note: For linking to successfully occur, the title of the material must be entered into the circulation 
database prior to linking.

1 On the computer, click Start > All Programs > Circuit Linking Utility. The Circuit 
Linking Utility appears.

Figure 10.6 Circuit Linking Window with Confirmation

2 Select the parameters for the media you are linking:
• if using a Content ID as an item identifier, click Select alternate item ID and then 

select either/both Use as item ID.
• ensure Confirm Linking is selected
• select No Security Circuit if you are linking a barcode and not an RFID tag
• select if using a Non-Locking Case (such as a jewel case)

3 If linking (RFID) security and content tags:
a Wave the case with the front label down over the tag pad with the disc(s) inside. 

The case tag and content tags are automatically sorted into the appropriate fields.
4 If linking a barcode (non-RFID) and content tags:

a Scan the barcode on the case. The case’s barcode number appears. This is the 
number to which the contents of the case will be linked.

Security ID

Content ID

History of Linked Items
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b Wave each disc over the tag pad; or if the disc(s) are inside the case, wave the 
entire case (front label up) over the tag pad. Hold the CD/DVD case from the 
bottom, face down when you wave the case over the tag pad.

5 Click Link. If the green checkmark appears, your material is now linked and ready to 
use. Retry the operation if a red X appears.

Linking Electronic Media Continuously
Use this procedure to prepare CD/DVD media for use within the ILS system. When 
continuously linking, no confirmation message appears, allowing you to link more 
quickly. Only link similar sets of media at one time to continuously link. For example, if 
linking cases with 2 DVDs each inside, select that parameter and link all of those at one 
time.

Note: For linking to successfully occur, the title of the material must be entered into the circulation 
database prior to linking.

1 On the linking computer, click Start > All Programs > Circuit Linking Utility.

Figure 10.7 Circuit Linking Continuously with Content ID as Item Identifier

Security ID

Content ID

History of Linked Items
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2 Select the parameters for the media you are linking:
• ensure Continuous Linking is selected
• if using a Content ID as an item identifier, click Select alternate item ID and then 

select either/both Use as item ID.
• select No Security Circuit if you are linking a barcode and not an RFID tag
• select if using a Non-Locking Case (such as a jewel case)

3 Select the # of media (discs) inside the case by clicking the up and down arrows and 
then clicking the number within the dialog box.

4 If linking (RFID) security and content tags:
a Wave the case with the front label down over the tag pad with the disc(s) inside. 

The security tag and content tags are automatically sorted into the appropriate 
fields. Hold the CD/DVD case from the bottom, face down when you wave the case 
over the tag pad.

Note: If the tag pad reads the content tags first, repeated beeps will be heard. Just ignore the beeps and 
try again. If the Item ID in the Security ID box is invalid, click Clear and try linking again.

5 If linking a barcode (non-RFID) and content tags:
a Scan the barcode on the case. The case’s barcode number appears. This is the 

number to which the contents of the case will be linked.
b Wave each disc over the tag pad; or if the disc(s) are inside the case, wave the 

entire case (front label up) over the tag pad.
6 If the green checkmark appears, your material is now automatically linked and ready to 

use. Retry the operation if a red X appears. Repeat the process as many times as 
necessary for the number of media and type of case selected.
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Removing Linked Media
You can remove electronic media from circulation with the Remove Media and Case Link 
window. This can be useful when material is incorrectly linked; for example, if a 
Beethoven disc becomes accidentally linked to a Schubert case, or if you remove the 
media from circulation.

1 On the linking computer, click Start > All Programs > Circuit Linking Utility.
2 Click Remove at the top menu bar. The Remove Media and Case Link window 

appears.

Figure 10.8 CD/DVD Circuit Removing Window

3 Select the parameters for the media you are linking:
• select Continuous Removal if removing multiple cases
• select No Security Circuit if you are removing a linked barcode

4 If removing security and content tags:
a Wave the case with the front label down over the tag pad with the disc(s) inside. 

The security tag and content tags are automatically sorted into the appropriate 
fields.

5 If removing a barcode and content tags:
a Ensure No Security Circuit is selected and scan the barcode on the case. The case’s 

barcode number appears. 
6 Click Remove, or if continuously removing, the material is automatically removed. 

Repeat the process as many times as necessary. If the green checkmark appears, your 
media are now removed. If a red X appears, the program cannot find the set in the 
database. 

Security ID

Content ID
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DVD Linking Reports
The Circuit Linking Utility generates information that can be compiled into reports. These 
reports are viewed and printed from ILS Remote Monitor. For general usage instructions 
on ILS Remote Monitor, reference the relevant chapter within the ILS User Guide.

Accessing and Printing Linking Reports
To launch ILS Remote Monitor in a single server, multi-branch environment:

1 Open a browser window.
2 Type http://<machine name of server>/ils in the address bar and press Enter. 

Optionally, use the saved bookmark in your Favorites menu.
3 Type your ILS Remote Monitor user name of ilsreport and the password report123. 

The ILS Remote Monitor utility displays.
4 From the top menu, click Branch and click Select of the branch where the Circuit 

Linking Utility resides. The branch location is programmed when installed. If the 
branch name is incorrectly installed, then you will not be able to run reports.

5 From the top menu, click Reports. The Report window displays.

Figure 10.9 CD/DVD Report Selection

The report types are explained below:

Table 10.1 CD/DVD Report Detail

Column Header Description
CD DVD Linking Summary Presents the details of what items were linked for CD/DVD 

material.

CD DVD Drop Box Exception Lists anomalies that occurred at the drop box for CD/DVD 
material.

CD DVD Staff Check-in Exception Lists anomalies that occurred during check-in at the Staff Station 
Reader for CD/DVD material.

CD DVD Check-out Detail Lists anomalies that occurred during checkout at the Staff Station 
Reader for CD/DVD material.
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6 Click the type of report desired. The window displays the options for defining the 
report.

Figure 10.10 Defining Report Parameters

7 Type the dates you wish for which you wish to view activity, or use the calendar 
buttons and select the date required.

8 Click Create Report once your dates are entered. 
9 To print the report, click File > Print. 
10 Select Landscape orientation and click OK.

Type of Reports
Listed here are descriptions of the available reports for the Intelligent Unlocking Station. 
See “Accessing and Printing Linking Reports” on page 10-11 for details on how to access 
and view reports.

Linking Summary Report
This report identifies exceptions generated from a Circuit Linking session.

Table 10.1 CD/DVD Linking Summary Detail

Column Header Description
ContentTagID The item number of the contents of the case.

SecurityTagID The item number of the case.

Link DateTime The day and time the item was linked.

Case The type of case that was selected when linked, Locking or Non-
Locking.

Title The title of the item.

LinkAuthor The name of the computer at which the linking occurred.

LinkStation The branch location of the computer at which the linking occurred.
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Check-out Detail Report
This report identifies exceptions generated from Self-Checkout Station sessions where an 
Intelligent Unlocking Station is attached.

Staff Check-In Exception Report
This report identifies exceptions generated from Staff Station Reader sessions where an 
Intelligent Unlocking Station is attached.

Drop Box Exception Report
This report identifies exceptions generated from Drop Box sessions.

Table 10.2 CD/DVD Check-out Detail Report

Column Header Description
StationType The type of device at which the exception occurred.

1. Drop Box
2. Staff Station
3. Self-Checkout Station

StationID The name of the station.

ExceptionType The name of the exception.

Tag The item identifier of the exception.

ExceptionDT The date and time when the exception occurred.

LibBranch The branch at which the exception occurred.

Table 10.3 CD/DVD Staff Check-In Exception Report

Column Header Description
StationType The type of device at which the exception occurred.

1. Drop Box
2. Staff Station
3. Self-Checkout Station

StationID The name of the station.

ExceptionType The name of the exception.

Tag The item identifier of the exception.

ExceptionDT The date and time when the exception occurred.

LibBranch The branch at which the exception occurred.

Table 10.4 CD/DVD Drop Box Exception Report

Column Header Description
StationType The type of device at which the exception occurred.

1. Drop Box
2. Staff Station
3. Self-Checkout Station

StationID The name of the station.

ExceptionType The name of the exception.

Tag The item identifier of the exception.
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ExceptionDT The date and time when the exception occurred.

LibBranch The branch at which the exception occurred.

Table 10.4 CD/DVD Drop Box Exception Report

Column Header Description
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C H A P T E R

CHAPTER 0CHECKPASS
This chapter describes the CheckPASS utility and explains how to use it. 

CheckPASS is an optional feature that allows library patrons to pay library fees at a 
Self-Checkout Station, without staff assistance. Outside of the ILS product, patrons use a 
self-service unit to add cash to their account balances. Within the ILS product, patrons are 
reminded of outstanding library fees when they attempt to check out materials. They can 
then pay with the touch of a button at the Self-Checkout Station. Patrons save time, and 
library staff is freed to perform other tasks.
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Using CheckPASS
If you have outstanding library fees, ILS displays the amount owed and prevents you from 
checking out material until the fee is paid. Take the following steps to pay the outstanding 
fee:

1 Scan your Patron Card. If ILS determines that you have outstanding fees, it displays 
the message shown in Figure 11.1.

Figure 11.1 Outstanding fee message

2 Touch Pay Fees to pay the fee. Touch Cancel to cancel the transaction. If you pay the 
fee, a confirmation message displays, showing your new account balance (Figure 
11.2).

Figure 11.2 Payment confirmation message
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3 Check out the library material, as normal.
4 If you have insufficient funds to pay the fee, the message shown in Figure 11.3 

displays.

Figure 11.3 Insufficient funds message

5 See a library staff member for assistance.
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Notes
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C H A P T E R

CHAPTER 0TROUBLESHOOTING GUIDE
This chapter describes procedures you can follow to try to correct problems that may arise 
with various ILS components. Problems and possible solutions are grouped by 
component, in the following sections:

• Patron Self-Checkout Station (page 12-1) 
• Application Server (page 12-4)
• Exit Interrogator (page 12-5)
• Staff Station Reader (page 12-6)
• CheckVIEW (page 12-9)
In addition, this chapter describes how to restart the Patron Self-Checkout stations 
(page 12-8), the Intelligent Library Controller software (page 12-8), and the Application 
Server itself (page 12-8). 

If these instructions do not produce the desired results, contact Technical Support at 
800-257-5540, ext. 4100. 

Contact Technical Support
Before calling technical support, note the date and time that the problem occurred, and list 
steps you have taken to try to correct the problem. 

Contact Checkpoint Technical Support at 800-257-5540 ext. 4100.

Self-Checkout Station Scenarios
Problem Valid Patron ID Not Recognized

When using the Barcode Scanner to scan a Patron ID, the Self-Checkout Station does not 
recognize the Patron ID...

Solution
1 Verify that the Self-Checkout Station is displaying the Patron Entry screen (video 

depicts a Patron ID being scanned). If so, be sure you are using the same reader 
depicted in the video. 
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2 Clean the Barcode Scanner lens.
3 Scan the Patron ID card again. The Barcode scanner beeps when it successfully reads a 

barcode. If it does not beep, restart the Self-Checkout Station (see “Restarting the 
Self-Checkout Station” on page 12-8).

4 If the problem persists after restarting the Self-Checkout Station, the scanner may be 
damaged or may require service or replacement. Contact Technical Support (see 
“Contact Technical Support” on page 12-1).

Problem Nothing Happens After an Item is Scanned
You scan an item and nothing happens...

Solution
1 If the video demonstrating an item checkout stops, the system is processing your 

request. Wait a few moments.
2 If the video demonstration continues without pausing after the item is scanned, the 

Self-Checkout Station did not register the item. Try scanning a different item.
3 If the video stops for more than 1 minute, follow the instructions for “Restarting the 

Self-Checkout Station” on page 12-8.
4 If the problem persists after restarting the Self-Checkout station, contact Technical 

Support. See “Contact Technical Support” on page 12-1.

Problem Graphics Display Incorrectly or Not at All
The graphics (pictures or video) are not displaying or are displaying incorrectly...

Solution
1 Network connection could have been lost while the Self-Checkout Station was starting. 

Check all network connections to the Self-Checkout Station and Application Server. 
2 If the connections are secure, restart the Self-Checkout Station. See “Restarting the 

Self-Checkout Station” on page 12-8.
3 If the problem persists after restarting the Self-Checkout Station, contact Technical 

Support. See “Contact Technical Support” on page 12-1.

Problem Printer Does Not Print
The printer does not print a receipt, or the Self-Checkout Station printer status reports an 
error...

Solution
1 Check that all receipts have been removed from the printer. Several receipts may be 

waiting to print. Remove each one, until all the receipts are printed.
2 Check that there is paper in the printer. To replace paper in the printer, see “Load Paper 

into Patron Self-Checkout Station Printer” on page 13-13. 
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3 If there is paper jammed in the printer, remove it, and reload the paper. See “Load 
Paper into Patron Self-Checkout Station Printer” on page 13-13 for instructions.

4 If the problem persists after following these steps, contact Technical Support. See 
“Contact Technical Support” on page 12-1.

Problem Printer Status of Unknown
The printer is working correctly, but the Self-Checkout Station status screen indicates a 
Printer Status of Unknown... 

Solution
This problem is sometimes caused by rebooting the Self-Checkout Station when print jobs 
are in the printer queue. You must attach a keyboard to the Self-Checkout Station to fix 
this problem.

1 Power off the Self-Checkout Station.
2 Attach a keyboard to the Self-Checkout Station, and then power it back on. Hold down 

one of the shift keys on the keyboard during the network logon display, to prevent the 
Self-Checkout Station program from starting. 

3 Select Start > Settings > Printers. 
4 Select File > Open.
5 Select the print jobs that are on hold, and delete them.
6 Close the windows you have opened, then select Start > Shutdown to shut down the 

Self-Checkout Station. 
7 Turn off the Power to the Self-Checkout Station, and remove the keyboard.
8 Turn on the power to the Self-Checkout Station.
9 If the problem persists after following these steps, contact Technical Support. See 

“Contact Technical Support” on page 12-1.

Problem Touch Screen Does Not Respond
The Touch Screen does not respond...

Solution
1 Check that the cable on the back of the monitor, which is plugged into the connection 

marked Touch Interface, is securely plugged in. 
2 If all the connections are secure, the Touch Screen may be operating properly but the 

Self-Checkout Station is not currently accepting input, or you are not touching a hot 
spot that accepts input. 
a Be sure that the Touch Screen monitor is powered on.
b Restart the Self-Checkout Station. See “Restarting the Self-Checkout Station” on 

page 12-8.
3 If the problem persists after following these steps, contact Technical Support. See 

“Contact Technical Support” on page 12-1.
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Problem Self-Checkout Station Fails to Start
The Self-Checkout Station fails to start during power up, and the screen displays an error 
condition...

Solution
1 Allow the scandisk program to run until it finishes.
2 Check all network connections on the Self-Checkout Station and the Application 

Server. If they appear to be secure, restart all of the Self-Checkout Stations. See 
“Restarting the Self-Checkout Station” on page 12-8 for instructions.

Note If the Application Server is shut down or loses power, all Self-Checkout Stations must be shutdown 
and restarted. See “Restarting the Complete System” on page 12-8 for details.

3 If the problem persists after following these steps, contact Technical Support. See 
“Contact Technical Support” on page 12-1.

Application Server Scenarios
Problem Self-Checkout Station Not Displaying

One or more Self-Checkout Station(s) is not displaying in the System Status Display...

Solution
1 Make sure the Self-Checkout Station is running. If it is not running, the error message, 

“We are currently unable to provide access to the system” displays. If this message 
displays, the problem involves the connection between the Self-Checkout Station and 
the Application Server. Make sure the network is connected and configured properly. 

2 If the Self-Checkout Station is running and behaving normally, but it is missing from 
the System Status display, restart the entire system. See “Restarting the Complete 
System” on page 12-8 for instructions.

3 If the problem persists after following these steps, contact Technical Support. See 
“Contact Technical Support” on page 12-1.

Problem Trouble Printing a Report
You cannot print a report...

Solution
1 Try to print a test page. Select Start > Settings > Printers. Right-click on the printer 

and select Properties. Click Print Test Page. 
2 If you cannot print a test page, consult Windows Help. 
3 If the test page prints successfully, contact Technical Support. See “Contact Technical 

Support” on page 12-1.
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Problem Error Message Displays when Running a Report
You receive an error message when running a report...

Solution
The printer might have run out of paper, or there may be a problem with the configuration 
database. Contact Technical Support. See “Contact Technical Support” on page 12-1.

Problem Exit Alarms Do Not Occur
Exit Alarms do not occur when they should...

Solution
1 Power down and restart each Exit Interrogator. 
2 Wait several minutes, then trigger an exit alarm. If no alarm occurs, restart the entire 

system. See “Restarting the Complete System” on page 12-8 for instructions.
3 If the problem persists after following these steps, contact Technical Support. See 

“Contact Technical Support” on page 12-1.

Problem Host Status Incorrectly Reports Offline
Host Status displays as Offline, when it is online...

Solution
The Host (LMS) Status indicator is accurate only when a Self-Checkout Station is running 
and properly connected to the Application Server. If no Self-Checkout Stations are 
connected, the Host Status field cannot be updated.

1 Make sure that at least one Self-Checkout Station is running. 
2 Check all network connections between the Self-Checkout Stations and the 

Application Server. If they appear to be secure, restart the Self-Checkout Stations. See 
“Restarting the Self-Checkout Station” on page 12-8.

3 Check that the Library Management System (LMS) is running. Restart the LMS, if 
necessary.

4 If the problem persists after following these steps, contact Technical Support. See 
“Contact Technical Support” on page 12-1.

Exit Interrogator Scenarios
Problem Exit Alarms Do Not Occur

Exit Alarms do not occur when they should...

Solution
1 Power down and restart each Exit Interrogator. 
2 Wait several minutes, then trigger an exit alarm. If no alarm occurs, restart the entire 

system. See “Restarting the Complete System” on page 12-8 for instructions.
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3 If the problem persists after following these steps, contact Technical Support. See 
“Contact Technical Support” on page 12-1.

Problem No Sound Occurs for an Exit Alarm
No Exit Alarm sounds, but an Exit Alarm displays on the Intelligent Library Controller...

Solution
1 Power down and restart each Exit Interrogator. 
2 Wait several minutes, then trigger an exit alarm. If no alarm occurs, restart the entire 

system. See “Restarting the Complete System” on page 12-8.
3 If the problem persists after following these steps, contact Technical Support. See 

“Contact Technical Support” on page 12-1.

Problem Incorrect Exit Alarm
Exit Alarm occurs, even though the item is properly checked out...

Solution
1 If your site allows off-line processing, the item may have been checked out while the 

LMS was offline. If you have not synchronized the Checkout Cache since the LMS 
returned to online status, do so now. See “Synchronizing the Checkout Cache” on 
page 2-8 for instructions. 

2 If the item was recently checked out using a circulation desk Staff Station Reader, turn 
off the Staff Station Reader used, then turn it back on. 
• If the problem persists, restart the ILS Controller application. See “Restarting the 

Intelligent Library Controller program” on page 12-8. 
3 If the patron used a Self-Checkout Station, go to a Library Management System 

terminal, and verify that the item was checked out. 
a If the LMS does not have a record of the checkout, check the item out now. 
b If the LMS verifies that the item was checked out, contact Technical Support. See 

“Contact Technical Support” on page 12-1.
4 If the problem persists after following these steps, contact Technical Support. See 

“Contact Technical Support” on page 12-1.

Staff Station Reader Scenarios
Problem Valid Circuit Not Recognized

The Staff Station Reader does not recognize a valid item Circulation Circuit...

Solution
1 Check to make sure the Staff Station Reader is running. 

a Check to make sure the power cord is connected to the Staff Station Reader and 
plugged into a power source, and that all the remaining cable connections are 
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secure. Refer to the connection diagram, “System Connection Diagram” on 
page 12-11. 

b You should feel air moving through the air vents located on the side of the Staff 
Station Reader.

2 Scan the item again. Check the LED on the back of the Staff Station Reader. The LED 
blinks green when the Staff Station Reader successfully reads an item ID. 
a If the LED blinks green, but the Staff Station still does not recognize the item ID, 

restart the Intelligent Library Controller software. See “Restarting the Intelligent 
Library Controller program” on page 12-8. 

b If the LED does not blink green, power off the Staff Station Reader, then power it 
back on. Wait approximately 30 seconds while the software initializes. 

3 Scan the item again.
4 If the item ID still is not recognized, contact Technical Support. See“Contact Technical 

Support” on page 12-1.

Problem Scanned Item Does Not Display on Monitor
Item scanned with Barcode Reader or Staff Station Reader does not display on the 
monitor...

Solution
1 If the item was scanned with the Barcode Reader, check the following:

a If the Barcode Reader has a separate power cord, check that it is connected to the 
Barcode Reader and plugged into a power source.

b Check that all cable connections are secure. The Barcode Reader should be 
connected to Com Port 4.

c Reader should beep when reading a barcode, and you should see the reader’s light 
on the barcode stripes. 

2 If the item was scanned with the Staff Station Reader, check the following:
a Check that the power cord is connected to the Staff Station Reader and plugged into 

a power source.
b Check that all cable connections are secure. The Staff Station Reader should be 

connected to the Keyboard Wedge, which is then connected to Com Port 3.
3 Scan the item again. 
4 If the problem persists:

a Disconnect the power to the Barcode Reader.
b Disconnect the power to the Staff Station Reader.
c Reconnect the power to the Barcode Reader.
d Reconnect the power to the Staff Station Reader.

5 Scan the item again. 
6 If the item ID still does not display, contact Technical Support. See “Contact Technical 

Support” on page 12-1.
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Recovery Procedures
You were directed to this section from another Troubleshooting scenario. Follow the steps 
outlined in the section to which you were directed, then return to the Troubleshooting 
scenario from which you came.

Restarting the Self-Checkout Station
1 Disconnect power to the Self-Checkout Station using the power switch at the rear of 

the case.
2 Wait approximately 10 seconds, then reconnect power to the Self-Checkout Station.
3 Allow the scandisk program to run until it finishes. This could take several minutes.
4 All necessary applications will start automatically.
5 Return to the Troubleshooting scenario from which you came.

Restarting the Complete System
1 Power off the Self-Checkout Station using the power switch at the rear of the case.
2 Shut down the Intelligent Library Controller software by selecting its Shutdown icon 

on the Windows Task Bar. Click Shutdown.
3 If error messages display, close them by clicking Abort, OK, or Cancel.
4 Click Start > Shutdown to shut down the Application Server.
5 After the Application Server reboots, power on the Self-Checkout Stations. All other 

necessary applications start automatically.
6 Return to the Troubleshooting scenario from which you came.

Restarting the Intelligent Library Controller program
1 At least one Self-Checkout Station must be running.
2 Shutdown the Intelligent Library Controller software by selecting its icon on the 

Windows Task Bar. Click Shutdown.
3 If error messages display, close them by clicking Abort, OK, or Cancel.
4 The Intelligent Library Controller software will be launched automatically.
5 If the program does not start within one minute, start the Intelligent Library Controller 

software by selecting Start > Programs > RFID.
6 Return to the Troubleshooting scenario from which you came.
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CheckVIEW Troubleshooting
If you encounter issues in using the CheckVIEW software, refer to the following solutions 
for possible answers.

Problem I have installed the CheckVIEW software, but I still cannot connect to the 
Self-Checkout Station.

Solution 1 - IP Address used on Staff computer
Ensure that the IP Address assigned in the Settings.xml file matches the IP Address used 
by the Self-Checkout Station. 

1 Launch Windows Explorer and navigate to C:\Program Files\Checkpoint Systems\
CheckVIEW Monitor\.

2 Open the Settings.xml file with Notepad.
a Right-mouse click Settings.xml.
b Select Open With...  and choose Notepad from the list of programs.

3 Search for the IP address of Self-Checkout Station being used. Ensure that the IP 
address used matches the IP address of the Self-Checkout Station.

Figure 12.1 Sample TCP/IP Settings

4 Close the Settings.xml file to save your changes.

Solution 2 - Correct default settings on Self-Checkout Station
You can also ensure that the Default Settings on the Self-Checkout Station are correct. 
Access the VNC Server Settings, as seen in Figure 12.2, by:

1 Either attach a keyboard or access the Self-Checkout Station using PcAnywhere.

IP Addresses should match

Sample Settings.XML of CheckVIEW for 
Self-Checkout Station 1

Sample TCP/IP Properties of a computer
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Click Start > All Programs > UltraVNC > Ultr@VNC Server > Show Default 
Settings. The Default Local System Properties window displays.

Figure 12.2 VNC Server Settings

2 Verify that:
• Accept Socket Connections is checked
• Password is checkpt
• Display Number is 10000
• Auto is deselected

• Enable Java Viewer is deselected
3 Click OK to save and close the window.
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System Connection Diagram

Figure 12.3 System Connection Diagram
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Notes
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C H A P T E R

CHAPTER 0SYSTEM MAINTENANCE
This chapter describes how to perform system maintenance tasks for the Intelligent 
Library Controller and other components of the ILS. It also provides safety information 
and system specifications.

Intelligent Library Controller System Maintenance
Intelligent Library Controller maintenance tasks include:

• Maintaining the transaction database (page 13-2)
• Synchronizing offline transactions (page 13-3)
• Backing up the transaction database (page 13-4)
• Purging the transaction database (page 13-5)
• Compacting the transaction database (page 13-7)
• Rebooting the Application Server (page 13-8)

The transaction database tasks listed above must be performed as a group, and in a 
certain order. The purge and compact tasks must be performed only during 
non-circulation hours. 

• Shutting down the Patron Self-Checkout stations (page 13-9)
• Shutting down the Intelligent Library Controller software (page 13-10)
• Backing up the Application Server (page 13-11)
• Loading paper into the Patron Self-Checkout Station printer (page 13-13)
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Transaction Database Maintenance
The transaction database size cannot exceed 1 GB. If 1 GB maximum limit is reached, no 
new data will be written to the database, the application server will log errors 
continuously, and database behavior becomes unpredictable. In fact, if the transaction 
database is allowed to reach a size of 500 MB, system performance suffers. To avoid this 
constraint, you can purge the transaction database. However, there are a number of 
preliminary and subsequent steps included in the task of purging the transaction database, 
including:

1 Synchronize offline transactions, if this feature is enabled. Offline processing allows 
you to continue check-in and checkout tasks, even if the Library Management System 
(LMS) is offline. You perform this task first so that offline transactions are included in 
the transaction database. See “Synchronize Offline Transactions” on page 13-3.

2 Make a copy of the transaction database, so that you have an archive of the 
transactions, in case the purge process fails or is interrupted. See “Backup Transaction 
Database” on page 13-4.

3 Purge the transaction database. You use the Purge function to mark transaction 
database records for deletion. This function does not remove rows from the database, 
so physical disk space is still allocated and used. Perform this function only during 
non-circulation hours. See “Purge the Transaction Database” on page 13-5.

4 Compact the transaction database. To physically remove the deleted records and 
reduce the size of the database, you must compact the database. Perform this function 
only during non-circulation hours. See “Compact the Transaction Database” on 
page 13-7.

5 Checkpoint Systems recommends that you then reboot the Intelligent Library 
Controller. See “Reboot the Application Server” on page 13-8.
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Synchronize Offline Transactions
If offline processing is enabled at your site, it allows you to continue check-in and 
checkout tasks when the LMS is offline. You use the Offline Synchronize function to 
move offline transactions into the transaction database when the LMS comes back online. 

Note You must synchronize offline transactions each time the LMS goes offline and then comes back 
online.

To synchronize offline transactions:

1 In the Intelligent Library System Control window, select Maintenance > Transaction 
Coordinator > Offline Synchronize. (If the Offline Synchronize option is grayed out, 
skip to “Backup Transaction Database” on page 13-4.)

Figure 13.1 Transaction Coordinator Offline Synchronization Navigation

2 Run a Checkout Discrepancy Report (See “Checkout Discrepancy Report” on 
page 2-14) and a Patron Discrepancy Report (See “Patron Discrepancy Report” on 
page 2-15). Resolve any discrepancies through the Library Management System. They 
cannot be resolved using the Intelligent Library System Open Plus.

3 Go to the next step, “Backup Transaction Database”, which follows this section.
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Backup Transaction Database
Before purging the transaction database, make a copy of it, so that you have an archive of 
the transactions, in case the purge process fails or is interrupted. 

Before performing this task, you should have synchronized offline transactions (if 
offline processing is enabled at your site). See “Synchronize Offline Transactions” on 
page 13-3. 

The location of the Transaction database varies depending on the directory chosen for 
installation of the ILS software. The base directory for the ILS software is usually 
C:\RFID. The Transaction database file is always located at 
RFID\Applications\DB\TransCoord\transaction.mdb. 

To create a backup copy of the transaction database: 

1 Right-click Start and select Explore to open Windows Explorer.
2 Navigate to the RFID\Applications\DB\TransCoord\ directory.
3 Right-click transaction.mdb and select Copy.
4 Navigate to the folder where you want to store the backup copy.
5 Right-click the white space within that folder's file listing and select Paste. 
6 After the file is pasted into the directory, rename the backup file. Highlight the file 

name and press F2.
7 Type the new name of the backup file. Be sure to retain the .mdb extension. Press 

Enter.
8 Go to the next step, “Purge the Transaction Database”, which follows this section.
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Purge the Transaction Database
Warning The Purge and Compact functions can cause unpredictable behavior or cause the system to go 

offline if used inappropriately. Only qualified system administrators should use these functions. 
Perform these functions only during non-circulation hours.

To determine how often to purge the transaction database, Checkpoint Systems 
recommends monitoring the size of the transaction database daily (or weekly) for several 
days (or weeks) and using the data gathered to estimate how often to purge the transaction 
database.

Purging and compacting the transaction database functions should be performed as a unit. 
After purging the transaction database, always compact the transaction database. 

Before performing this task, you should have performed the following tasks:

1 Synchronize offline transactions, if offline processing is enabled at your site 
(“Synchronize Offline Transactions” on page 13-3)

2 Backup the transaction database (“Backup Transaction Database” on page 13-4)
To purge the transaction database:

1 In the Intelligent Library System Control window, select Maintenance > Transaction 
Coordinator > Purge.

Figure 13.2 Purge Navigation

2 Enter the ILS user name and password in the ILS Login window. The default user 
name is ils, and the default password is maint. Click OK.
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3 During the purge operation, a progress indicator displays to show you how much of the 
purge has been completed and how much remains. 

Figure 13.3 Purge Progress Indicator display

When the purge is finished, the End Purge message box displays.

Figure 13.4 End Purge message box

4 Go to the next step, “Compact the Transaction Database”, which follows this section.
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Compact the Transaction Database 
Warning The Purge and Compact functions can cause unpredictable behavior or cause the system to go 

offline if used inappropriately. Only qualified system administrators should use these functions. 
Perform these functions only during non-circulation hours.
To physically remove the deleted records and reduce the size of the transaction database, 
you must compact it.

Purging and compacting the transaction database functions should be performed as a unit. 
After purging the transaction database, always compact the transaction database. 

Before performing this task, you should have performed the following tasks:

1 Synchronize offline transactions, if offline processing is enabled at your site 
(“Synchronize Offline Transactions” on page 13-3)

2 Backup the transaction database (“Backup Transaction Database” on page 13-4)
3 Purge the transaction database (“Purge the Transaction Database” on page 13-5)
To compact the transaction database:

1 In the Intelligent Library System Control window, select Maintenance > Transaction 
Coordinator > Compact.

Figure 13.5 Compact Navigation

2 Enter the ILS user name and password in the ILS Login window. The default user 
name is ils, and the default password is maint. Click OK.

3 When the compact function is finished, a message box displays.

Figure 13.6 End Compact message box

4 Go to the next step, “Reboot the Application Server”, which follows this section.
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Reboot the Application Server
After purging and compacting the transaction database, Checkpoint Systems recommends 
that you reboot the Application Server. 

Before performing this task, you should have performed the following tasks:

1 Synchronize offline transactions, if offline processing is enabled at your site 
(“Synchronize Offline Transactions” on page 13-3)

2 Backup the transaction database (“Backup Transaction Database” on page 13-4)
3 Purge the transaction database (“Purge the Transaction Database” on page 13-5)
4 Compact the transaction database (“Compact the Transaction Database” on page 13-7)
To reboot the Application Server:

1 Shut down all Patron Self-Checkout stations. See “Shutdown Patron Self-Checkout 
Stations” on page 13-9.

2 Shut down the Intelligent Library Controller software. See “Shutdown the Intelligent 
Library Controller Software” on page 13-10.

3 Click Start > Shutdown to shut down the Application Server.
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Shutdown Patron Self-Checkout Stations
Before rebooting the Intelligent Library Controller, you must shut down the Patron Self-
Checkout Stations. To shut down the Patron Self-Checkout Stations:

1 In the Intelligent Library System Control window, select Maintenance > Shutdown > 
Self Check Stations. 

Figure 13.7 Shutdown Patron Self-Checkout Station

2 Enter the ILS user name and password in the ILS Login window. The default user 
name is ils, and the default password is maint. Click OK.

Figure 13.8 ILS Login window

3 In the Self Check Shutdown window, click Yes to perform the shutdown. Click No to 
cancel the shutdown of the Self-Checkout Station.

Figure 13.9 Self Check Shutdown window
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Shutdown the Intelligent Library Controller Software
To shut down the Intelligent Library Controller software:

1 Be sure that all Patron Self-Checkout Stations are shut down. See “Shutdown Patron 
Self-Checkout Stations” on page 13-9.

2 In the Intelligent Library System Control window, select Maintenance > Shutdown > 
AppServer. 

3 Click Shutdown.

Figure 13.10 Shutdown Button
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Backup the Application Server
This section describes how to back up all files on the Application Server and how to 
restore them, as needed. Before you can perform the backup, you must exit the Intelligent 
Library Controller application.

Checkpoint Systems recommends that you do not use the Application Server’s hard drive 
as your backup medium. 

Backup
1 Shut down the Patron Self-Checkout stations. See “Shutdown Patron Self-Checkout 

Stations” on page 13-9.
2 Exit the Intelligent Library Controller application.
3 To launch the Windows backup utility, select Start > Programs >Accessories > 

System Tools > Backup. 
4 Click on the Backup tab. (If you would rather use the Backup Wizard to perform the 

backup, click the Backup Wizard button and follow its directions.)

Figure 13.11 Backup window

5 Select the drives and/or directories that you want to back up.
a The directory required to restore the Intelligent Library System Open Plus is 

E:\RFID.
b Select any other applications used at your site to communicate between the LMS 

and the ILS.
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6 Click Start Backup. Respond to prompts as they appear. See the MicroSoft Windows 
Help for detailed instructions for using the Backup Utility.

Figure 13.12 Backup tab

Restore
Restoring files from a backup tape can take a long time.

1 Follow steps 1 through 3 from the Backup instructions.
2 To restore individual files from a backup set on a tape, select the Tapes window, then 

load the catalog of the backup set from which you want to restore certain files.

If the catalog of backup files is not visible, you may have to create a new one. See the 
Microsoft Windows Help for instructions.

3 Select all the files you want to restore using the appropriate method:
a To select contiguous files, click the first filename, hold down SHIFT, and click the 

last contiguous filename.
b To select non-contiguous files, click a filename, hold down CTRL, and click each 

filename.
c On the Select menu, click Check. A check mark displays in the check box for each 

selected file.
4 On the Operations menu, click Restore.
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Load Paper into Patron Self-Checkout Station Printer

Do not touch the cutter blade *
There is a sharp cutter blade inside the paper outlet slot. Do not put your 
hand in the paper outlet slot when changing paper or while printing is in 
progress.
Use the following procedure to reload the paper in the Self-Checkout Station.

1 Lift to remove the printer access cover from the top of Self-Checkout Station chassis. 
You will see the printer unit (shown below) through the opening.

Figure 13.13 Self-Checkout Station Printer

2 Pull the bar release lever (top right) towards you to release the paper roller bar 
assembly.

3 Lift the paper roller bar assembly all the way up until it rests back in the open position.
4 Remove the used paper roll core from the printer and discard it.
5 Remove the tab on the new paper roll.

Protect Yourself From Injury
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6 Set the new paper roll into the printer, and pull on the leading edge of the paper from 
the bottom toward you (as shown below)

Figure 13.14 Self-Checkout Station Printer - New Roll Installation

7 Make sure there is enough excess paper so that approximately 1/8” of paper is coming 
through when you close the paper roller bar assembly.

8 Close the paper roller bar assembly by pushing it down until it snaps closed securely.
9 As soon as you close the paper roller bar assembly, the paper will automatically feed 

and cut off the end of the paper.
10 Remove and discard the excess piece of paper that was cut off in the previous step.
11 Replace the printer access cover, and push down to secure it to the unit with the hook 

and loop fasteners.
Note The paper will feed through the small slit opening in the printer access cover during self checkout 

transactions.
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Safety Warnings
Barcode Scanner:

LASAR RADIATION

RISK TO EYES - DO NOT STARE INTO BEAM

CLASS 2 LASER PRODUCT

Figure 13.15 Laser Radiation Icon

See the Metrologic Instruments IS 4110 and IS4120 ScanQuest® Laser Scan Engine 
Installation and User’s Guide on other Safety instructions, warnings and technical 
specifications.
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Specifications

Mechanical
Dimensions: 29" L x 20.75" W x 6.25" H

(736.60 mm x 527.05 mm x 158.75 mm)

Weight: 26 lbs. (9.7 kg)

Materials: Acrylic / PVC alloy

Monitor: See the Planar PT1503NT User’s Manual.

Electrical
Emissions: FCC Part 15, RSS 210, ETSI 300 330 Compliant

Immunity: ETSI 301489 Compliant

RF Transmit Frequency: 13.56 MHz

Demodulation type: AM

Read range: Up to 10" with a 2.1" x 2.1" Circulation Circuit®

Console Power Requirements: 24 VDC, 50-60 Hz, 1.6 A

Safety: Requires dedicated circuit to prevent power surges and spikes from damaging the 
system. Requires power strip with power and modern surge protection. UL/cUL 60950-1 
compliant.

Interfaces
Diagnostics: RS-232

Host: IEEE 802.3, 10 Base-T Ethernet, NE 2000 Compatible Read range

Peripherals
Monitor: Touch Screen 15" flat screen - standard

Printer: Star Micronics TSP 600 Series (643C)

Patron Card Reader (standard): Metrologic IS 4120

Power Supply: 90-264 VAC, 47 - 63 Hz IEC input, 24 VDC @ 4A output, UL Listed

Environmental
Operating temperature: 32 degrees F to 104 degrees F (0 degrees C to 40 degrees C)

Storage Temperature: -22 degrees to 140 degrees F (-30 degrees C to 60 degrees C)

Storage/operating humidity: 5% to 95%, non-condensing

Tag Compatibility: RFID Based Circulation Circuit
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